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Installation of Olis SpectralWorks

Olis SpectralWorks is a comprehensive program for 
the dynamic display and analysis of 2D and 3D data 
files collected as a function of time, temperature, 
titration, pressure, concentration, or other variables. The 
SpectralWorks program includes GlobalWorks, which is 
used for data analysis and display, and is available from 
Olis as a separate program.

The following pages will walk you step by step through the 
installation process, from System Requirements, to Setup, 
to Registration of your software. You will soon be on your 
way to using the best 3D data handling and fitting software 
package in the world!

System Requirements

Recommended Hardware:

• PII or AMD 500 MHz or better processor

• 256 MB RAM

• 40 MB free hard drive space 

• 800x600 resolution 

• 256 colors minimum

Recommended Operating Systems:

• Windows ™ 2000, XP

Software Requirements:

• Internet Explorer ™ 5.5 or higher 

• HTML Help 1.3 or higher 

Note that both Internet Explorer and HTML Help are 
required to support interactive tutorials.

(Windows and Internet Explorer are trademarks of the 
Microsoft ™ Corporation.)

Setup Procedure

1. Insert the SpectralWorks software CD into the 
CD drive of the computer.

2. The installation program should start 
automatically. If it does not start after a minute, 
click on Start, then Run, and browse to the CD 
drive. Choose Setup.exe on the CD. Click OK to 
run the setup (see Figure 1.1).

3. At the start of installation, the install welcome 
screen will appear. Click Next to continue (see 
Figure 1.2).

4. Click Yes to agree to the License Agreement.

5. When installing the software, ensure that the 
computer you are installing it on meets the 
minimum requirements (see Figure 1.3 or refer 
to System Requirements on page 2). 

NOTE: Do not install GlobalWorks if SpectralWorks is already installed 
on your system (i.e., if the software runs an instrument, SpectralWorks 
is installed).

Figure 1.2 
Install Welcome Window

Figure 1.3 
System Requirements

Installation of SpectralWorks
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9. The installation progress will be updated during 
the setup process (see Figure 1.7).

10. During the installation process, a parameter file 
with the name <Instrument>Params.xml will be 
created in c:\Program Files\OLIS GlobalWorks\
ParaXML directory.  The <instrument> may be 
DM45, SLM, RSM or another instrument.  This 
file will contain all parameters necessary for 
running of the instrument.  It is advisable to save 
a copy of this file in a secure location.

6. Select the destination location where 
GlobalWorks will be installed. The default 
directory is C:\Program Files\OLIS GlobalWorks. 
All Olis files, including demo data files, will be 
created in this directory (see Figure 1.4).

7. Choose the setup type (see Figure 1.5). It is highly 
recommended that Typical be chosen. If a copy of 
SpectralWorks is already installed on the computer, 
this screen will differ. The options will be Modify 
(choose this to add a feature), Repair (choose this 
to reinstall the software over an existing version 
of GlobalWorks), and Uninstall (choose this to 
remove the program). 8. Select the program folder 
to be created. This is the menu folder where the 
GlobalWorks program icon will be located in the 
Windows Start menu (see Figure 1.6).

Figure 1.4
Choose Destination Location

Figure 1.5 
Setup Type Window

Figure 1.7
Setup Status Window

Figure 1.6
Select Program Folder Window

Installation of SpectralWorks
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11. The software will report when this installation 
is complete (see Figure 1.9). Click Close to 
continue. You will then see a window that will list 
your computer restarting options. 

12. After the installation has completed, two 
windows will appear. 

 Press any key to continue. This process will 
allow users other than the Administrator to use 
GlobalWorks (see Figure 1.10).

13. The installation of GlobalWorks is now complete. 
If you have not restarted your computer, or if it 
does not automatically restart at this point, it is 
recommended that you manually restart your 
computer at this time.

If a Previous Version of GlobalWorks Exists on the 
Computer:

1. The installation will proceed automatically.

2. The automatic installation will be followed by 
the appearance of two windows. These set 
permissions to allow additional users to access 
SpectralWorks in the Windows environment. 
Press Enter for each window. The parameter file 
installed will use values extracted from the old 
parameter file.  A backup of the original file will 
be stored in c:\Program Files\OLIS GlobalWorks\
ParaXML <Date>.

Figure 1.9
Installation Complete Window

Figure 1.10
Folder Permissions Window

Installation of SpectralWorks
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Introduction to SpectralWorks

a. General organization of SpectralWorks

i. SpectralWorks controls the instrument 
through the use of five or six tabs.  Clicking 
on each tab causes the controls to become 
visible.  The Temperature Controller tab will be 
present if a software controlled temperature 
controller is installed on the instrument. 

ii. Live Display page This page contains 
most of the direct instrument controls.  
Wavelength ranges, number of data 
points to be collected, and detector gains, 
among others, are controlled on this page.  
Numerical data outputs are also displayed 
on this page.

iii. Operational Modes page The modes 
of data collection and presentation are 
controlled on the Operational Modes page.  
This includes the Data Reduction Mode 
(how data are calculated), Data Collection 
Mode (wavelength scan, time drive, stopped 
flow, etc.).  Other miscellaneous modes and 
settings are located on this page as well.  

iv. Repeated Scans page Multiple scans, 
assays, or stopped flow shots are set up 
on this page.  These data collection events 
are collected automatically and presented 
as a single dataset.  Data can be collected 
as a function of time or one of several Olis 
scripts, including Temperature, Titrator, 
Enzyme Assay Device, Wavelength, or 
Sample Angle changer.  The titrator manual 
control form is also accessed from this page.  

v. X and Y Axes page This page allows control 
of axis scale, including an autoscale setting.  
Instruments with stopped flow capability 
contain controls for two graphs (raw data 
and calculated data).  Color controls are also 
on this page.

Introduction to SpectralWorks
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vi. Parameters page Several miscellaneous 
controls are located on this page, including 
a software reset button, active detector 
selection, and a stopped flow sensor map (if 
present). 

vii. Temperature Controller If the instrument Temperature Controller If the instrument Temperature Controller
is equipped with a software controlled 
temperature controlled device (Peltier or 
water bath), the Temperature Controller 
page will be visible.  All direct controls of the 
temperature controller are located on this 
page.  Temperature scripting is set on the 
Repeated Scans page. 

viii. Experiment Window After collection 
datasets are posted to the Experiment 
Window, usually located in the upper right 
corner of the screen.  Navigation among the 
datasets can be accomplished by clicking 
on the associated icons in this window.  
Datasets created by data processing will 
also create icons in this window. 

ix. Properties Window The Properties Window 
contains information about the dataset 
such as the date and time the dataset was 
collected.  The only property which can be 
changed is the Name.  This can be changed 
by double-clicking on the name and entering 
a new one.

x. Menu bar The menu bar is used primarily Menu bar The menu bar is used primarily Menu bar
for data analysis, viewing and processing, 
so is discussed more thoroughly in the 
GlobalWorks manual.  However, several 
members of the File menu including Open 
Experiment, Save Experiment, Open 
Protocol, and Save Protocol are discussed in 
this portion of the manual.

Introduction to SpectralWorks
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Screen Shots and Descriptions
a. Start-Up Display

i. This display appears at startup and contains 
shortcuts for opening files and instrument 
setup. Identical on all Olis programs.

 Existing
 Select this tab to open a dataset or 

experiment already acquired and stored.
Recent
Access data that has recently been opened 
or saved.

 Data Collection
 Select this tab to open a data acquisition 

mode to start using the spectrophotometer.
 Tutorials
 Select this tab to open the tutorial on Global Fitting.

b. Live Display
i. Displays current instrument settings and 

collection data. Instrument specific, yet 
largely identical on all Olis programs.

 Excitation wavelength
 The current wavelength of the excitation 

monochromator is displayed here and can 
be changed by clicking on the text box and 
entering in the desired wavelength.

 The keystroke shortcut for entering the 
Excitation Wavelength is W.

 Emission wavelength
 The current wavelength of the emission 

monochromator is displayed here and can 
be changed by clicking on the text box and 
entering in the desired wavelength. If more 
than one monochromator is present, both 
monochromators will move to this value.

 The keystroke shortcut for entering the 
Emission Wavelength is A.

 Scan Range (excitation)
 Starting and ending wavelengths for the 

excitation monochromator are displayed 
here. To take an excitation scan, enter 
the starting and ending excitation 
wavelengths, then enter the desired 
emission wavelength, a constant value, 
as both the starting and ending emission 
wavelengths. The X-axis on the graph will 
read Excitation Wavelength.

 If synchronous scanning is desired (both 
excitation and emission monochromators 
scanning), then enter the desired scan 
range for both monochromators.

 The keystroke shortcuts for entering the 
starting and ending wavelengths for the 
excitation monochromator are F and T, 
respectively.

Screen Shots and Descriptions
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 Scan Range (emission)
 Starting and ending wavelengths for the 

emission monochromator are displayed 
here. To take an emission scan, enter the 
starting and ending emission wavelengths, 
then enter the desired excitation wavelength, 
a constant value, as both the starting and 
ending excitation wavelengths. The X-axis 
on the graph will read 

 Emission Wavelength.
 If synchronous scanning is desired (both 

excitation and emission monochromators 
scanning), then enter the desired scan range 
for both monochromators.

 The keystroke shortcuts for entering the 
starting and ending wavelengths for the 
emission monochromator are M and O, 
respectively.

 Selected Emission Monochromator
 Not shown. If two emission monochromators 

are present, choose the appropriate 
monochromator to scan with this option.

 The choices offered are Emission 1, 
Emission 2, or Both.

 Sample Number
 Not shown. If the instrument is equipped 

with an automated sample turret, the current 
sample cuvette position is displayed here. 
This position can be changed by clicking on 
the number and choosing a new position.

 Number of Increments to Collect
 The number of intervals to be collected in 

each scan or assay is entered here.

 The keystroke shortcut for entering the 
Number of Intervals to Collect is N.

 Current Scan Number
 If multiple scans are to be collected, the 

current scan and total scan numbers are 
displayed here.

 Integration Time
 The time spent collecting data per each data 

point is shown here. The upper limit is 10 
min/datum with an analog PMT and 2.44 
seconds with a photon counting system.  
The minimum settings are 0.0000005 
seconds for an analog PMT and 0.010 sec 
for a photon counting module.

 The keystroke shortcut for entering 
Integration Time is I.

 Current Sample Temperature
 If the instrument is equipped with an active, 

Olis-recognized temperature controller, the 
Current Sample Temperature is displayed 
here and is updated when the instrument is 
in Live Mode or during data collection. This 
is the bath or Peltier cell temperature unless 
the controller is equipped with an external 
temperature probe.

 Shutter Control
 This option will be available if automated 

shutters are present on the instrument. 
To open or close a shutter, click on the 
appropriate column for each shutter.

 Clicking the checkbox under Open Only 
During Data Collection causes the shutter 
to automatically open when data is being 
collected or when in Live Mode and close 
when data collection is finished. This option 
is especially useful for photosensitive 
samples.

=  # of INCREMENTS +1NUMBER 
OF POINTS
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 Polarizer Control
 The position of the polarizers is displayed 

here and can be changed by selecting a 
new position in the drop-down menu. The 
available options are 0°, 15°, 30°, 45°, 75°, 
90°, Vertical (0°), Horizontal (90°), Magic 
Angle (54.7°), User-Defined, Park (Usually 
45°) and At Sensor (usually ~90°). By far 
the most common of these are Vertical 
and Horizontal. If polarizers are manual, 
a prompt will appear requesting that the 
polarizer be moved to the new position.

 Raw PMT Signals
 The raw PMT signals (in volts) are shown 

in real time here when in Live Mode. They 
are color coded red and blue to match the 
corresponding PMTs. Generally, the blue 
PMT is used in the reference position.

 If the PMT is saturated, this reading will 
be 10.000V in Live Mode. When this is the 
case, the light intensity reaching the PMT 
must be reduced by either reducing sample 
concentration, monochromator slit width, or 
PMT High Voltage.

 Calculated Data
 The current calculated fluorescence data is 

presented here. This value will depend on 
the Data Reduction Mode

 For example, when Ratio is chosen, the data 
provided in this location will be Sam/Ref, the ratio 
of the red PMT signal to the blue PMT signal.

 Polarization or anisotropy data is also 
presented here. 

 See Appendix 2 for more information on 
anisotropy data.

 Current PMT High Volts
 The current PMT high volts are shown 

here. To change this voltage, click on the 
number and enter the desired voltage. To 
automatically adjust high volts, use the Auto 
Adjust HV button.

 The keystroke shortcuts for setting the PMT 
high volts are H for the red PMT and P for 
the blue PMT.

 Manual PMT High Volts Control
 This option turns on or off the high volts 

(HV) to the photomultiplier tubes and is only 
available when Manual High Volts is selected 
in the Operational Modes tab.

 Apply Baseline
 This box is checked when a baseline is 

applied to the data. Once a baseline is 
selected, the number of data points and 
scan range cannot be changed without 
deselecting the baseline. To undo a baseline, 
uncheck this box by clicking on it.

Screen Shots and Descriptions
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 Live Mode
 Click on this button to enter the instrument 

into Live Mode. In this mode, data is 
collected but not stored. In addition displays 
such as current signals and sample 
temperature are updated continuously.

 Exit Live Mode by pressing the Escape 
key on the keyboard or clicking on the Esc 
button. It is recommended that this mode 
be exited before performing data analysis or 
exiting the program.

 The keystroke shortcut for entering Live 
Mode is V.

 Collect Data
 Clicking on this button will begin the data 

collection process. With the Data Collection 
Mode set to Scan, the instrument will scan 
the number of points from start to finish. With 
the Data Collection Mode set to Assay, the 
data will be collected at a fixed wavelength 
as a function of time. 

 The keystroke shortcut for Collect Data is D.

 Auto Adjust HV
 This button causes the PMTs to adjust high 

volts to give a PMT signal in the range of 2-8 
volts. It is important that a signal be present 
when this button is clicked (shutters open, 
sample in place, slits appropriate). No data 
are collected during this process.

 The keystroke shortcut for Auto Adjust HV is U.

 Stop (Esc)
 Clicking on this button or pressing the 

Escape key exits from Live Mode. If pressed 
during data collection, the current assay or 
scan is terminated and the instrument goes 
to Idle Mode, in which case the truncated 
dataset can be retained. 

 Note: If the Manual HV Shut Off check box 
in the Operational Modes tab is not selected, 
then the PMT HV will automatically shut off 
when exiting Live Mode.

 Post these Data
 Clicking this button stores current data only in 

memory and not on the hard disk. Posted data 
are transferred to data processing, where they 
can be manipulated, fitted, or saved to a disk. 
Data that are not posted will be overwritten 
when new data are collected. The option to 
post data will also be given in a prompt at the 
end of data collection.

c. Live Display (Polarization/Anisotropy)
i. Displays current instrument settings if 

polarization/anisotropy is chosen as the data 
reduction mode.

 Polarizer Control
 The position of the polarizers is displayed 

here and can be changed by selecting a 
new position in the drop-down menu. The 
available options are 0°, 15°, 30°, 45°, 75°, 
90°, Vertical (0°), Horizontal (90°), Magic 
Angle (54.7°), User-Defined, Park (Usually 
45°) and At Sensor (usually ~90°). By far 
the most common of these are Vertical 
and Horizontal. If polarizers are manual,
a prompt will appear requesting that the 
polarizer be moved to the new position.

Screen Shots and Descriptions
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 Raw PMT Signals
 The raw PMT signals (in volts) are shown 

in real time here when in Live Mode. They 
are color coded red and blue to match the 
corresponding PMTs. Generally, the blue 
PMT is used in the reference position.

If the PMT is saturated, this reading will 
be 10.000V in Live Mode. When this is the 
case, the light intensity reaching the PMT 
must be reduced by either reducing sample 
concentration, monochromator slit width, or 
PMT High Voltage.

 During T-format polarization measurements, 
the red and blue PMTs are expected to be 
in the vertically and horizontally polarized 
channels, respectively.

 Polarization or Anisotropy Data:
 The current calculated polarization or 

anisotropy data are presented here. 
Polarization or anisotropy is chosen in Data 
Reduction Mode in the Operational Modes tab.

 For T-format polarization and anisotropy this 
value is updated continuously in Live Mode. 
For L-format polarization and anisotropy, 
conversion to polarization and anisotropy is 
done after data is collected.

 The calculation of polarization or anisotropy 
data requires a G-factor. 

 See Appendix 2 for more information on 
polarization and anisotropy.

 G-factor
 The current G-factor (Gain-factor) is reported 

here. This factor corrects for polarization 
effects on monochromator throughput and 
PMT sensitivity. See below on how to collect 
and accept an appropriate G-factor.

See Appendix 2 for details on how the G-
factor is determined.

 G-Factor Collection Time
 This value is the integration time (in seconds) 

for G-factor collection. The longer this time, 
the more reliable the G-factor value will be. 
Since this value is used in every subsequent 
calculation, it is important to obtain a reliable 
G-factor. To change this value, click on the 
time and enter the desired collection time.

 Accept G-factor
 Clicking this checkbox after collection of 

G-factor accepts the current value factor accepts the current value factor and 
prepares the polarizers for data collection. 
All subsequent polarization measurements 
will use this G-factor value.

 Collect G-factor
 Clicking this button initiates the G-factor

collection procedure. The software gives the 
option of entering a G-factor or measuring one.

 If a new G-Factor is entered, the program 
will move the polarizers (if they are 
automated) or prompt the user to move 
the polarizers (if they are not automated), 
in order to collect the G-factor. Once this 
process has finished, the new G-factor can 
be accepted (see above) or the process can 
be repeated by clicking on G-Factor again. 
Once a G-factor is accepted, the G-Factor 
button will change to Collect Data. When 
the Collect Data button is pressed the data 
collection procedure will be initiated.

 See Appendix 2 for more information on G-
factor and polarization and anisotropy. 

Screen Shots and Descriptions
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d. Operational Modes
i. Displays current data collection and data 

reduction modes. Contains additional options.

 Data Reduction Mode
 This option chooses the mode in which data 

will be presented. The options available are 
dependent on the number of polarizers and 
detectors available.

 For one PMT the following options are available:
Signal: Signal is reported directly with no 
mathematical manipulation of the data. 
The signal is reported in volts for a PMT or 
counts for a photon counter.

Fluorescence:  Same as signal output, 
except the Y-axis label is fluorescence.

 Photon Counting: Used when the photon 
counter is selected as the detector on the 
Parameters page.  Data are reported as 
counts, which can be normalized to counts/
sec on the Operational Modes page.

 For two PMTs the following options are available:
 L-Format Anisotropy: This option is 

available if at least two polarizers are present. 
Data are collected as fluorescence intensity 
for both vertical and horizontal emission 
polarizers and computed to give anisotropy. 
See Appendix 2 for details on this calculation.

 L-Format Polarization: This option is 
available with at least two polarizers. Data are 

collected as fluorescence intensity for both 
vertical and horizontal emission polarizers 
and computed to give polarization. See 
Appendix 2 for details on this calculation.

 T-Format Anisotropy: This mode is 
available with two detectors, and three 
polarizers. Data is collected as a ratio of 
detector signals (one channel vertically 
polarized, the other horizontally). This data 
is converted automatically to anisotropy. See 
Appendix I for details on this calculation.

T-Format Polarization: This mode is 
available with two detectors, and three 
polarizers. Data are collected as a ratio 
of detector signals (one channel vertically 
polarized, the other horizontally). These data 
are converted automatically to polarization. 
See Appendix I for details on this calculation.

 Ratio: In this mode, the emission signal 
is reported as a ratio of sample signal 
to reference signal. Fluctuations in lamp 
intensity are corrected for by this method.

 Single Beam: This mode reports the raw signal 
from the sample and reference channels.

 Data Collection Mode
 The option of taking scans, assays or 

stopped-flow data is given here. Scans are 
taken as a function of wavelength. Individual 
or repeated scans can be taken as a function 
of time, temperature or another variable. 

Assay data are taken at a single wavelength 
as a function of time. When the Data 
Collection Mode is set to Assay, the total time 
of assay is changed in the Live Display tab.

 The stopped flow mode also collects data as 
a function of time and requires a stopped-
flow apparatus to function. Note that single 
point (single wavelength) data can be 
obtained by setting the Data Collection 
Mode to Assay and setting the Number of 
Increments to Collect to 1.

 The keystroke shortcut to change Data 
Collection Mode is C.

Screen Shots and Descriptions
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 Detector Options
 Check Manually Shut of HV in order to have 

control over turning the high volts on and off 
when in Live Mode. Uncheck Manually Shut 
of HV to keep high volts under computer 
control. With this option unchecked, the 
PMT high volts will be turned off whenever 
data is not being collected. This is the 
safest mode for the PMTs to prevent 
damage due to saturation.

 If the user prefers that the PMTs remain on 
when the instrument is not collecting data, 
this option should be checked. Care must be 
taken in this case to avoid exposing the PMTs 
to room light while a PMT HV is applied.

 Reverse Beam Mode simply switches the 
red and blue signals for calculation. This has 
the effect of inverting the signal and can be 
used when the blue channel is to be used as 
the sample (vertical) polarizer.

Scan Mode
 There are four possible scan options for the 

fluorometer.  

Constant Bandwidth:  In this mode, 
the slit width is changed to maintain a 
constant bandwidth, while the PMT HV 
are adjusted to compensate for light 
intensity changes. This option is only 
available on instruments with computer 
controlled slit widths.

Fixed Slit Width:  In this mode, the 
slit width does not change, and PMT 
HV are changed to compensate for 
changes in light intensity.  This is the 
only mode available for instruments 
with computer controlled slit widths.

Fixed PMT HV:  In this mode, the 
PMT HV remain at a user-specified 
fixed value, while the slits adjust to 
compensate for light intensity changes. 
If no adjustable slits are present, 
everything will remain at a fixed 
position.

Fixed PMT HV and Slit Width
 In this mode, neither PMT HV or slit width 

is adjusted during the measurement.  
Ininstruments without motorized slits, this 
module is functionally identical to Fixed 
PMT HV.

Time Units
 This option changes the time units for data

collected as a function of time. Hours, minutes, 
seconds, or milliseconds are available.

 End of Scan Optionsof Scan Optionsof
 Not shown. This choice determines whether 

the monochromator returns to the start 
position after a scan or remains at the end 
position. Stop at End of Scan is used when 
the sample is photosensitive.

 Wave Units
 Choose between data being reported in

wavelength (nm) or wave number (cm-1).

Screen Shots and Descriptions
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e. Repeated Scans
i. Allows collection of multiple scans or assays 

in a single dataset.

 Number of Scans
 Enter the number of scans or assays to be 

repeated here. After they are acquired, all 
of these scans will be included in a single 
3-D dataset for storage and subsequent 
handling. 

 The keystroke shortcut for entering the 
number of scans is N.

 Repeat Scans as a Function of
 Repetitive scans can be collected as a 

function of None, Time, Temperature Script, 
Titration Script, or Enzyme Assay Script. 

None: Scans are collected 
consecutively, as quickly as possible, 
without pause. This is a useful mode for 
averaging several scans.

 Time: Scans are equally spaced out 
over the designated amount of time. The 
incubation period between scans can be 
skipped by pressing the spacebar, with the 
remaining scans being spaced out over the 
remaining time.

 Temperature Script: When repeated 
scans are acquired as a function of 
temperature (either by water bath or 

Peltier cell), an Olis script is used. The 
instrument will automatically adjust the 
temperature, incubate a prescribed 
amount of time and collect data when 
Collect Data is clicked in the Live 
Display tab. The resulting scans will 
be presented in a 3-D dataset with 
wavelength, temperature, and signal 
intensity as the three axes. The script is 
selected and edited as described in Edit 
Script. The instrument must be equipped 
with a water bath or Peltier cell that is 
compatible with Olis software. 

 Titration Script: To use this option the 
instrument must be equipped with an 
Olis titrator. In this mode additions of 
titrant are made automatically between 
scans or assays.  The resulting dataset 
is a 3-D data set with wavelength, 
concentration, and CD intensity as 
axes. The script is used and edited as 
described. The Titrator Control Panel 
also becomes active when this mode is 
selected. 

 Ezyme Assay Script: If the SLM is 
equipped with an enzyme assay device, 
assays may be collected as a function 
of concentration. As opposed to the 
titrator, a fresh solution is pushed into 
the cuvette as prescribed in a script. The 
enzyme assay control panel becomes 
active when this mode is selected.

 Total time for scans (units)
 This option is active when Collect Scans as 

a Function of Time is selected. The program 
will compute the required wait time between 
scans, so as to give equal intervals between 
scans or assays. If a time is entered that 
is less than the amount of time required to 
complete the scans, they will be collected as 
fast as possible (i.e., no wait time between 
scans). This option is disabled when 
collecting in rapid scanning mode.
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 The keystroke shortcut for changing Total 
Time forScans is T.

Script Name
 This display shows the location of the current 

active script file. A new file can be selected
by clicking on the filename and entering in 
the new file. Alternatively, pressing ‘Browse’ 
allows the user to open the new script file. 
Script files have the extension .osf.

 Edit Script
 The current active script can be edited by 

clicking on this button. Changes in the script 
must be saved (under the File menu) before under the File menu) before under
exiting. The script can also be edited using 
the program Notepad, which is included 
in Microsoft Windows. Note: Do NOT use 
Wordpad or any other word processing 
software to change the script. This may 
corrupt the script file format.

Scan Method
 Choosing Auto causes the intrument to 

operate entirely without user intervention. 
When a script file is being run, this option is 
automatically set to Auto.

 Selecting Manual results in a pause between 
each scan durring which time the space bar 
must be pressed in order for data collection 
to be resumed. This method is useful if the 
sample nas to be manipulated between 
scans.

 The keystroke shortcut for setting the Scan 
Method to Auto is A.

Average Scans
 Selecting this option will automatically 

average all scans into one 2-D scan as the 
final result. If this option is not checked, the 
data can be averaged later. Choosing to 

average scans cannot be undone, as only 
the average is saved, not the raw data.

 The keystroke shortcut to activate Average 
Scans is R.
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f. X & Y Axes
i. Options for editing the axis scale and 

displaying colors.

 X-axis
 This option changes the scale of the X-axis 

during data collection. The data are not 
affected by changing this scale; only the 
display is affected.

The keystroke shortcuts to access the X-axis 
minimum and maximum values are M and A, 
respectively.

 Y-Axis
 This option changes the scale of the Y-

axis (the fluorescence intensity) during 
data collection. The data are not affected 
by changing this scale; only the display is 
affected.

 The keystroke shortcuts to access the Y-axis 
minimum and maximum values are N and X, 
respectively.

 Auto Scale Y-Axis
 This option allows the graphic to be automatically 

scaled continuously during data collection. This is 
particularly useful if the user does not know the 
amplitude of the expected signal.

The keystroke shortcut for selecting Auto 
Scale Y-axis is O.

 Y-Axis (Raw Data)
 This option changes the scale of the raw signal 

of the PMTs. This signal can be accessed 
by double clicking on the graph, during data 
collection. The data are not affected by 
changing this scale; only the display is affected.

 The keystroke shortcuts to access the Y-axis 
minimum and maximum value are I and S, 
respectively.

Auto-Scale (Raw Data)
 This option will allow the raw signal graphic

to be automatically scaled continuously 
during data collection. This is particularly 
useful if the user does not know the 
amplitude of the expected signal.

 Pressing keystroke for activating Auto Scale 
Raw Data is U.

 Change Line Color
 This control allows the user to change the line color 

during data collection. Up to nine different colors 
can be used from a palette of hundreds of colors.

 Change Background Color
 This control allows the user to change

the chart background color during data 
collection. Up to nine different colors can be 
used from a palette of hundreds of colors.
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g. Parameters
i. Contains controls for checking calibration, 

checking stopped-flow sensors, and 
changing active detectors.

 Hardware Reset and Calibration
 Clicking this button will result in calibration 

of the monochromator and any other 
associated motors. Recalibrating should be 
performed if any problems are encountered. 
If problems persist, contact Olis.

 The keystroke shortcut for Hardware Reset 
and Calibration is R.

Get Version Information
 This button allows for reading of the current 

hardware versions on your instrument. 
This information can be very useful when 
receiving technical support from Olis.

 The keystroke shortcut for Get Version 
Information is G.

Active Data Collection Devices
 This is a list of all possible detectors on the 

instrument. Check the detectors that will be 
active here. Be sure to update the current 
data in reduction mode to reflect any change 
in number of detectors. The available 
modes will depend on the number of active 
detectors.

Stopped Flow Sensor Map
 For Stopped flow only. This display shows

the current readings of the stopped-
flow sensors and will only be present if 
instrument is equiped with a stopped-flow 
apparatus. When in Live Mode, this map 
will continually update. A similar display is 
shown on the front of the Electronics box. In 
order for the stopped flow to fire, no sensors 
can be showing red as its sensor state. To 
update the map when not in Live Mode, click 
on the “Get SF State” button.

FS and BS refer to the front and back 
syringes, respectively. The syringes must be 
in contact with the pneumatic drive block in 
order for these sensor states to not be red. 

 BH and FH are the respective front and back 
handles. These move the syringe valves 
from Fill to Flow.  These valves must be on 
Flow to fire the stopped flow, and Fill to fill 
the syringes.

 SS refers to the stop syringe. The plunger 
in the stop syringe must be down for the 
stopped-flow to fire. This can be pressed 
down by moving the exhaust valve to empty 
and pushing down on the shaft. The syringe 
will be in the up position after each firing of 
the stopped-flow.

 EH refers to the exhaust handle. This valve 
must be in Flow position for the stopped flow 
to fire.
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 When all valves and syringes are in their 
proper positions for firing, the Ready light will 
become green. If data collection is attempted 
when the Ready light is not green, the 
stopped flow will not fire, and the program 
will go to this map to tell the user to move 
the offending valve or syringe.

 Get SF State
 For Stopped flow only. If the instrument 

is not in Live Mode, click on this button to 
update the sensor map. This will detect 
any valves or syringes, which are in 
inappropriate position.

 Fire Stopped-Flow
 For Stopped flow only. Clicking this button 

will cause the stopped-flow to fire without 
collecting data as long as the Ready light on 
the Stopped-Flow Sensor Map is green.

Disable Stopped-Flow
 For Stopped flow only. Clicking on this 

checkbox disables the stopped flow such 
that when Data Collection is chosen, data 
are collected, but the stopped-flow does 
not fire. This mode is especially useful for 
diagnostic purposes and is not available in 
Rapid Scanning Stopped Flow.

Recover Safe DataRecover Safe DataRecover
 A backup of each dataset is created after 

each data collection. Upon normal exiting of 
the program, these files are erased. In the 
event of a power failure or other disruption of 
data collection, previously collected data can 
be restored by clicking on this button and 
selecting the desired dataset to restore.

h. 2D Data Display
i. Data display for 2-D datasets.

 Comments
 This section allows for the user to add 

comments that will remain with the file when 
it is saved. After data collection, useful 
instrument settings will be reported here.

 Selected Data Parameters
 This table indicates the location of the 

cursor, which can be activated by clicking on 
the data. 

 The X and Y values are recorded under 
Absorbance and Wavelength. None refers 
to the fact that there is no third axis (i.e. the 
data is 2-dimensional).  
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 The Index column refers to the datum 
number of the data set. Only independent 
variables will have an index value (e.g., time, 
scan number, wavelength).

Experiment Window
 Every open window, including the data 

collection window (not shown above) is listed 
in the Experiment Window. When a new data 
set or fit is generated, a new entry is added 
to this window. Move between windows by 
clicking on the data sets in this window. To 
delete a window, make it the current window, 
and click in the lower X in the right corner.  

The dataset name, which can be changed 
in the Properties Window, is followed by the 
filename in parentheses. Data are not saved 
if file name is not present.

 Datasets can also be selected for data 
processing here by right clicking and 
choosing Select. The data processing 
options become active in the right click 
menu. Among these options are arithmetic, 
smoothing, and averaging of data.

 Properties Window
 This window lists properties of the file being 

displayed, such as number of data points, 
date collected, and data set name.

 The data set name can be changed here by 
double clicking on Name and entering in a 
new name followed by the return key. This 
is not the file name, but only a name for 
display that will be saved with the data.

 Data can be saved by selecting Save As 
under the File menu

i. 3D Data Display
i. Data display for 3-D datasets.

 2-D Data View
 Pressing this button displays the  3-D data 

as two 2-D slices. In this case one graph 
would have overlayed spectra and the other 
has the kinetic trace at one wavelength. This 
option is also available under the view menu.

SVD
 This button initiates analysis of the data 

using the Singular Value Decomposition 
algorithm. This process can be used to 
globally fit 3-D data or as a noise filter for 
the data. This option is also available under 
the Fits menu. A tutorial on SVD is available 
in the Start-Up Display. 

Data
 The number of scans to be displayed are 

changed here. A step of “1” shows all data 
up to 200 scans.

Screen Shots and Descriptions



22

Scale
 Clicking this option allows the axis scales to 

be changed. Autoscale is also available.

Rotation
 Clicking this option allows the view to be 

changed. Degree rotation of axes can be 
entered or the graph can be dragged after 
checking the Rotation box.

j. 2D Data Display (Multiple Trace)
i. Displays datasets as 2-D slices. Allows 

simultaneous view of overlayed spectra and 
kinetic trace.

 Lock On Slice
 Once the cursor is active by clicking on 

data, you may select this option to lock on 
a particular slice of data. Moving the cursor 
allows you to travel along the selected scan 
exclusively. Information on the “locked on” 
slice will appear dynamically in the Selected 

Data Parameters window. This option is also 
availableunder the Edit menu.

 Dynamic Slicing
 Clicking on this button after selecting a scan 

from the collected data will dynamically

display slices at the selected wavelength 
in the other graph. This option is available 
only in the 2-D view. This option is also 
availableunder the Edit menu.

Remove Cursor
 Once a slice is selected and the cursor 

appears, this button will deactivate the 
cursor. This option is also availableunder the 
View menu.

Hide Slice
 When the data cursor is active on a slice, 

this option allows you to remove from display 
to a hidden clipboard. This option is also 
availableunder the View menu.

 Unhide Slice
 When this option is selected all previously 

hidden slices will reappear. If multiple scans are 
hidden, all will reappear simultaneously. This 
option is also availableunder the View menu.

 Swap Slices
 This feature allows you to swap visible 

slices with slices that have been hidden with 
the Hide Slice option. This option is also 
availableunder the View menu.

 3-D View
 This option allows viewing of the 3-D 

datasets as a 3-D image. The 3-D image 
can then be manipulated. This option is also 
available under the View menu.
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k. Data Display Options Menu
i. Right-clicking on a scan brings up these 

display options.

 Scaling
 To change the scale of either the X or Y axis, 

select this option.  A window will appear to 
prompt the new scaling values.

 Autoscale
 Choosing this option causes the X and Y 

axis to be autoscaled.

Save As ASCII
 This option allows for a 2-D dataset to be 

exported as a two column, tab-delimited
ASCII text file with no headers or footers.  

 If this option is selected for a 3-D dataset, 
the highlighted 2-D dataset will be exported.

Export Data to Excel
 This feature will open the current data

set (2-D or 3-D) into Microsoft Excel as 
a spreadsheet. Microsoft Excel must be 
installed on the computer for this feature to 
work.

Assign as Open
 Clicking this option assigns the highlighted

scan as the “open” scan for scan correction. 
The “open” scan should be a scan with no 
sample in the beam and should ideally give 
a 100% transmission. 

Assign as Blocked
 Selecting this option assigns the highlighted

scan as the “blocked” scan for scan 
correction. This scan is taken with the 
shutter closed and should ideally give 0% 
transmission.

Assign as Baseline
 Selecting this option will cause the 

highlighted scan to be assigned as a
baseline, causing this dataset to be 
subtracted from subsequent measurements. 
“Baseline” will appear in the Live Display 
and the Apply Baseline checkbox will be 
checked. Data collected must be equal to 
the baseline in number of points and scan 
range in the Properties window.
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a. Initializing the instrument

i. Be sure that the instrument has be turned on 
before proceeding to initialize the instrument.  
To begin using the instrument use the 
Startup menu, which opens automatically 
upon starting the software, and move to the 
‘Data Collection’ tab.  Click on the instrument 
name and click on ‘Open’.  Note that 
occasionally the software is used to control 
two instruments or two hardware settings 
which are different enough to be considered 
as two instruments by the software.

ii. Alternatively, the toolbar data icon can be 
clicked on to start the instrument.  There 
will be multiple icons available for software 
controlling multiple instruments.  Hover the 
mouse pointer over the icon to identify it.

iii. During the initialization process, all electronics 
boards will be set to their default settings and 
all motors will be calibrated.  This typically 
involves moving the motor a given direction 
until a sensor switch is encountered.  This 
identifies the motor’s “home” or calibrate 
position.  This position is assigned a value 
(e.g. wavelength) and all subsequent motor 
movements are based on this assignment.  In 
addition to motor calibration, communication 
is established with all accessories including 
water baths, titrators,  and sample changers.  
The screen will be updated as to the current 
procedure that the software is running by the 
purple display above the graph.

iv. When the instrument has finished calibrating, it 
will return to the last used settings.  Once this 
has finished the instrument will enter ‘Idle Mode’ 
meaning that it is waiting for a command.

b. Entering and exiting Debug Mode

i. The software is equipped with a Debug 
Mode in which the software can be run with 
no instrument present.  In this mode, a green 
button labeled Debug Mode will appear in 
the upper right corner of the Live Display 
screen. 

ii. To exit debug mode, ensure that the 
instrument is powered on and click on the 
green debug mode button.  The instrument 
will calibrate as it does during startup.

iii. To enter debug mode from the normal 
operating mode, press the ctrl+alt+shift+d 
keys simultaneously.  A confirmation 
message will appear.  Answering ‘OK’ will 
place the instrument in Debug mode.
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c. Collecting a wavelength scan

i. A wavelength scan involves collecting 
data as a function of wavelength.  This 
wavelength change is effected by a 
monochromator and is directed by the scan 
range

ii. Ensure that the Data Collection Mode in the 
Operational Modes page is set to ‘Scan.’ 

iii. On the Live Display page, enter the 
wavelength range, Number of Increments, 
and Integration time (expressed as Reads 
per Datum in some instruments).   Note 
that the software may automatically adjust 
the ending wavelength value if the entered 
Number of Increments is too large for given 
wavelength range. 

iv. Place the sample in the sample chamber 
unless a baseline is to be collected.  See 
‘Applying a Baseline’ for details on baseline 
collection.  Click on ‘Collect Data’ to begin 
data collection.  The data will be displayed in 
the data graph as data are collected.

d. Posting Data to GlobalWorks

i. At the end of data collection (except for 
rapid scanning mode in an RSM), the 
following message will appear.  Choosing 
‘Yes’ will result in the current data being 
transferred to the Experiment Window.  
Data processing procedures are described 
in the GlobalWorks section of this 
manual.  Choosing ‘No’ will post nothing 
to GlobalWorks.  The current data will be 
overwritten the next time data are collected 
(including Live Mode).

ii. At any time, except during data collection, 
the current data may be transferred to 
GlobalWorks, by clicking on the ‘Post these 
Data’ button located in the upper right corner 
of any screen.

e. Collecting and applying a new baseline

i. If a baseline scan is to be applied to a 
wavelength scan.  Collect a wavelength 
scan of either the empty chamber or cuvette 
containing buffer or solvent as described in the 
section entitled ‘Collecting a wavelength scan.’

ii. Post the data when prompted to do so.

iii. Click on the data to highlight it.  The data will 
become yellow and a cursor will appear.

iv. Right-click on the data and choose ‘Apply 
Baseline’ from the resulting pop-up menu.  

v. The program will return to the Live Display 
page, showing that the Apply Baseline 
checkbox has been checked.  In addition the 
label BASELINE will appear to the right of 
this checkbox.  This baseline will be applied 
to subsequent scans until the Apply Baseline 
checkbox has been unchecked.  Note, that 
a new baseline must be applied if the scan 
range or number of increment is changed.
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f. Applying a previously collected baseline

i. If the intended baseline file is not already open, 
choose Open Dataset under the File menu.

ii. Click on the dataset in the Experiment 
Window to highlight it.

iii. Ensure that the intended baseline has an 
identical scan range and number of points 
(number of increments + 1) as the current 
Live Display settings by looking in the 
Properties Window. 

iv. Right-click on the icon associated with the 
dataset in the Experiment Window.  Choose 
‘Assign as baseline’ from the pop-up menu.  
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v. The program will return to the Live Display 
page, showing that the Apply Baseline 
checkbox has been checked. This baseline 
will be applied to subsequent scans until 
the Apply Baseline checkbox has been 
unchecked.  Note, that a new baseline must 
be applied if the scan range or number of 
increment is changed.

g. Collecting an assay (time drive)

i. Click on the Operational Modes page and 
ensure that the Data Collection mode is set 
to Assay.

ii. On the Live Display screen, set the Number 
of Increments and the Total Time for 
Assay.  Note that the Integration Time will 
automatically determined to maximize data 
collection time.  This value can be changed 
by clicking on Integration time. 

iii. The time units can be changed in the 
Operational Modes page.

iv. Click on ‘Collect Data’ to begin the assay.  

v. The program will prompt the pressing of the 
spacebar to begin data collection.  The time 
between clicking Collect Data pressing the 
spacebar is recorded as the incubation time.  
This will be displayed in the Comments 
section of the dataset. 

vi. In addition to the incubation time, the 
average value of the dataset will be 
displayed in the Comments box of the 
dataset.

Non Instrument-Specific Procedures



28

h. Collecting a data point at a single wavelength

i. Follow the instructions for collecting an 
assay.  Use the Total Assay time as the 
integration time of the single point.  After 
collecting data, the average value will be 
displayed in the Comments section of the 
dataset.

i. Collecting and averaging multiple scans

i. On the Live Display page set the instrument 
parameters as desired for a single scan or 
assay.

ii. On the Repeated Scans page ensure that 
‘Repeated scans as a function of…’ is set to 
None. 

iii. Set the Number of Scans to the desired 
value on the Repeated Scans page.

iv. Click on the Average Scans checkbox.  This 
will result in one final two-dimensional scan 
which is the average of the scans.  If this 
checkbox is not checked, the entire group 
of scans will be retained.  These may be 
averaged later in GlobalWorks.

v. Choose the Scan Option which determines 
whether scans will occur automatically or 
user prompted.

vi. On the Live Display page, click on ‘Collect 
Data’ to begin data collection.

j. Collecting Scans as a function of time

i. On the Live Display page set the instrument 
parameters as desired for a single scan or assay.

ii. On the Repeated Scans page ensure that 
the ‘Repeated scans as a function of …’ is 
set to Time. 

iii. Set the Number of Scans to the desired 
value on the Repeated Scans page.

iv. Set the Total Time for  Scans to the desired 
total time.

v. Choose the Scan Option to Auto or Manual 
which determines whether scans will occur 
automatically or user prompted.

vi. On the Live Display page, click on ‘Collect Data’ 
to begin data collection.  If the Scan Option 
is set to Auto the scans will be automatically 
spaced out over the given time.  At any time 
the incubation time between scans can be 
circumvented by pressing the spacebar.
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k. Changing the axis scaling

i. On the X and Y Axes page enter the desired 
minimum and maximum values for the Y-
Axis.  Uncheck the Autoscale checkbox 
to use the entered values.  If autoscale is 
desired, check the autoscale checkbox.  

ii. The X-axis value can be changed by 
entering new values in the X-Axis entry box.

iii. The scaling changes in SpectralWorks 
do not affect the dataset once it has 
been posted to GlobalWorks.  Scaling in 
GlobalWorks is achieved by right-clicking on 
the data and choosing Scaling from the pop-
up menu.

l. Changing the background color

i. On the X and Y Axes page, click on the 
‘Change Background Color’ button.

ii. Use the color palette to choose the desired 
background color.  Click ‘OK.’

m. Changing the line colors

i. Choose the line number of the line that you 
wish to change.

ii. On the X and Y Axes page, click on the 
‘Change Line Color’ button.

iii. Use the color palette to choose the desired 
background color.  Click ‘OK.’ 

n. Resetting and recalibrating the instrument

i. Occasionally, it may be desirable to restart the 
instrument without having to restart the software.  
An example of this is if the control box is turned 
off.  After this has occurred, it would be a good 
idea to recalibrate the instrument.

ii. On the Parameters page click on the 
‘Hardware Reset and Calibration’ button.  

iii. The instrument will repeat the procedure that 
it goes through during startup.  This includes 
resetting of electronics, calibration of motors, 
and communication with accessories.

Non Instrument-Specific Procedures



30

o. Creating, saving, and opening protocols

i. Protocols allows the saving of instrument 
settings so that a given procedure can be 
saved as a file.  To save a protocol, set the 
instrument to the desired settings.

ii. Exit Live Mode if necessary.

iii. Choose the Save Protocol from the File 
menu to save a protocol.

iv. Enter a file name for the protocol and click 
OK.  

v. To open a protocol choose ‘Open Protocol’ 
from the File menu.  Note that all protocols 
are located in the Program files\OLIS 
Globalworks\Protocols.

vi. Answer ‘OK’ to the protocol confirmation 
message.  This indicates that current 
parameter settings will be replaced with ones 
from the protocol.

p. Attaching a protocol to a dataset

i. Collect a dataset using the instrument 
settings that are intended to be saved in the 
protocol.

ii. Click on ‘Save Dataset with Protocol’ from 
the File menu. 

iii. Enter a name for the protocol.  Protocols will 
be stored in the Protocols folder of the OLIS 
GlobalWorks folder and will have a ‘.olp’ file 
extension. 
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iv. Choose a name for the dataset.  The dataset 
location is not limited as the protocol is.  

v. When the file is opened, a message box will 
appear indicating a protocol is associated 
with it.  Choose ‘Yes’ to load the protocol or 
‘No’ just to open the dataset.

q. Recovering Backup data

i. A backup file is automatically created after 
each scan or assay.  This is saved in a 
directory labeled by the data and time.  The 
folder is located in the c:\Program Files\
OLIS GlobalWorks\SafeData folder.  After a 
specified amount of time (30 day default) the 
files will be deleted.

ii. To recover lost data, click on the Recover 
Safe Data button and locate the folder 
containing the desired dataset.  This folder 
will be labeled by the date and time of data 
collection. 

iii. Select the first scan of the dataset and click 
Open.  The dataset will be automatically 
recombined and opened.

r. Changing the time to store backup data

i. Simultaneously press ctrl+shift+alt+a to open 
the administration screen.
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ii. Click on the DCGUI node to expand it.  

iii. Locate the parameter called 
DaysToKeepSafeData.  Click on the 
parameter and enter the desired number of 
days to keep the data.

iv. Press enter and close the administration 
screen.

5. Fluorescence specific Procedures

a. Collecting data as a ratio or single detector

i. On the Parameters page, select the number 
of PMTs (or photon counters) to be used 
in the measurement.  If a single detector 
is to be used, only one detector should be 
selected.  Likewise, if ratio is to be used, 
both a red PMT (or photon counter) and blue 
PMT (reference) must be selected.

ii. On the Operational Modes page, select 
either ‘Fluorescence’ for a single PMT or 
‘Ratio.’  Select the desired Data Collection 
Mode (‘Scan’ for wavelength scan or ‘Assay’ 
for single wavelength time drive).  Note that 
the contents of this list will depend on the 
number and type of detectors selected in the 
above step.  For example ‘Ratio’ will not be 
available if only one detector is selected to 
be used. 
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iii. On the Live Display page, click on the Live 
Mode button to view the signal.  Follow the 
instructions below for collecting data.  

b. Collecting a fluorescence emission scan

i. On the Operational Modes page, ensure that 
the Data Collection mode is ‘Scan’ and the 
Scan Mode is ‘Fix Everything’.  The Data 
Reduction mode should be ‘Fluorescence’ 
or ‘Ratio’ depending on whether a reference 
PMT is to be used. 

ii. Set the excitation wavelength range to the 
desired excitation wavelength.  Both the 
‘Scan To’ and ‘Scan From’ wavelengths 
should be identical.  

iii. Set the emission wavelength range to the 
desired range.  If the scan range is changed 
automatically by the software, it indicates 
that the entered wavelength is impossible 
for the instrument to achieve.  Note that for 
fluorimeters equipped with two emission 
monochromators and option switch is 
present next to the scan range.  This switch 
allows to the user to choose to scan one or 
both of the monochromators.

iv. Click ‘Collect Data’ to being data collection.  

c. Collecting a fluorescence excitation scan

i. On the Operational Modes page, ensure that 
the Data Collection mode is ‘Scan’ and the 
Scan Mode is ‘Fix Everything’.  The Data 
Reduction mode should be ‘Fluorescence’ 
or ‘Ratio’ depending on whether a reference 
PMT is to be used.  Note the content of the 
Data Reduction Mode list is dependent on 
the number of detectors selected on the 
Parameters page.  

ii. Set the emission wavelength range to the 
desired emission wavelength.  Both the 
‘Scan To’ and ‘Scan From’ wavelengths 
should be identical. 
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iii. Set the excitation wavelength range to the 
desired range.  If the scan range is changed 
automatically by the software, it indicates 
that the entered wavelength is impossible for 
the instrument to achieve.  

iv. Click ‘Collect Data’ to being data collection.  

d. Collecting a fluorescence assay

i. On the Operational Modes page, ensure 
the Data Collection mode is ‘Fixed 
lambda assay, slow’ and the Scan Mode 
is ‘Fix Everything’.  The Data Reduction 
mode should be ‘Fluorescence’ or ‘Ratio’ 
depending on whether a reference PMT is to 
be used.  

ii. Set the excitation wavelength and emission 
wavelengths to the desired values. 

iii. Enter the total time for the assay to 
complete.  If desired change the time units 
in the ‘Time Units’ section of the Operational 
Modes page.

iv. Enter the number of data point to be 
collected.  The integration time will be 
automatically determined.

v. Click ‘Collect Data’ to being the assay, and 
press the spacebar to begin data collection.  
The time between clicking ‘Collect Data’ 
and pressing the spacebar is termed the 
incubation time.  This is recorded and 
displayed in the Comments section.  

e. Collecting a single wavelength fluorescence 
intensity value

i. On the Operational Modes page, ensure that 
the Data Collection mode is ‘Fixed lambda 
assay, slow’ and the Scan Mode is ‘Fix PMT 
HV and slit width’.  The Data Reduction 
mode should be ‘Fluorescence’ or ‘Ratio’ 
depending on whether a reference PMT is to 
be used. 

ii. Set the excitation wavelength and emission 
wavelengths to the desired values.
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iii. Enter the total time for the assay to 
complete.  This will be the integration time 
for determining the fluorescence intensity.  If 
desired change the time units in the ‘Time 
Units’ section of the Operational Modes 
page.

iv. Enter the number of data points to be 
collected and averaged.  The integration 
time for each data point will be automatically 
determined, but the total incubation time will 
be that given in the total assay time.

v. Click ‘Collect Data’ to being the assay, 
and press the spacebar to begin data 
collection.  The average value for the entire 
assay will be calculated and displayed in 
the Comments section.  The time between 
clicking ‘Collect Data’ and pressing the 
spacebar is termed the incubation time.  This 
is recorded and displayed in the Comments 
section.

f. Using the manual PMT high volts setting

i. On the Operational Modes page, check the 
Manual PMT HV checkbox.  A control switch 
will appear above the PMT HV controls on 
the Live Display page.

ii. The PMT HV will not shut off until the switch 
is set to the ‘off position.’  If the Manual PMT 
HV checkbox is not checked, the PMTs will 
turn off when the instrument is not collecting 
data.

g. Collecting G-factor for anisotropy or 
polarization

i. On the Parameters page, select the number 
of detectors to be used in the polarization 
or anisotropy measurement.  Two detectors 
must be chosen for T-format and for L-format 
in the ratio mode.  One detector must be 
chosen for the L-format measurement.  

ii. On the Operational Modes page, choose 
‘L-format polarization’, ‘L-format anisotropy’,  
L-format anis. (ratio), L-format polar. (ratio), 
‘T-format anisotropy’, or ‘T-format anisotropy’ 
from the Data Reduction mode list.  Note 
that both L-format (ratio) and T-format 
selections require two detectors.  L-format 
ratio requires the second detector to be in 
the excitation reference position, while T-
format requires two emission detectors.  

iii. On the Live Display page, enter the desired 
wavelengths, and choose an appropriate 
integration time for the G-factor, called the 
‘G-factor Time.’  The units are seconds.  
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iv. With the sample in place, click on the ‘Live 
Mode’ button to view the current signals.  
Adjust the PMT HV to give a signal of 0.1 
V to 8 V.  Move the polarizers to all four 
possible positions to be sure that the signal 
remains in an appropriate range. 

v. Click on ‘G-factor’ to collect the G-factor.  
The user will have the option to enter a 
previously determined G-factor or to collect a 
new one. 

vi. If collection of G-factor is selected.  Data will 
be collected for the amount of time given 
as the G-factor time.  If a predetermined 
G-factor is used, enter this value when 
prompted.  

vii. If the G-factor seems valid, click the Accept 
G-factor checkbox.  This will change the G-
factor button to a ‘Collect Data’ and apply 
the G-factor to all subsequent data collected.  
To measure a new G-factor, first uncheck the 
Apply G-factor checkbox.

h. Collecting a single wavelength anisotropy or 
polarization

i. Choose the appropriate Data Reduction 
Mode on the Operational Modes page.  
Note, that this list is sensitive to the 
number of active detectors selected on the 
Parameters page.  

ii. Choose ‘Fixed lambda assay, slow’ as the 
Data Collection Mode on the Operational 
Modes page. 

iii. On the Live Display page, set the Emission 
and Excitation wavelengths, the Total Assay 
time, and click on the ‘Live Mode’ button to 
read the live signals.  Adjust the PMT HV to 
give signals between 0.5 and 9 V.  Move the 
polarizers into all possible positions to be 
sure that the signal stays below 10 V. 
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iv. Click on ‘G-factor’ to collect a G-factor 
or enter a new one.  If the polarizers are 
controlled manually, follow the instructions 
for moving the polarizers.  

v. Click on the ‘Collect Data’ button to 
begin data collection.  If the polarizers 
are to be moved manually, a message 
will appear each time a polarizer is to be 
moved.  Automated polarizers will move 
automatically, and by default a message 
will be displayed as an indicator of the 
movement.  These messages are optional 
and may be removed by accessing the 
administration screen by simultaneously 
pressing ‘ctrl + shift + alt + a.’  Click on each 
polarizer node and find the parameter called 
‘NotifyUserOfMovement.’  Change this value 
to a 1 on each polarizer, press enter, and 
exit the administration screen. 

vi. For L-format measurements, a message will 
appear after each collection asking if the 
raw data are to be posted to Globalworks.  
This dataset will be posted as an individual 
dataset in addition to the final calculated 
dataset. 

vii. Click ‘yes’ to the question of posting the 
dataset to GlobalWorks.  The dataset will 
contain data taken over the total assay 
time.  The average value over this time is 
displayed in the Comments section. 

i. Collecting an excitation scan of anisotropy or 
polarization

i. Choose the appropriate Data Reduction 
Mode on the Operational Modes page.  
Note, that this list is sensitive to the 
number of active detectors selected on the 
Parameters page. 

ii. Choose ‘Scan’ as the Data Collection Mode 
on the Operational Modes page.  
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iii. On the Live Display page, choose 
the Number of Increments, Emission 
Wavelength, and Excitation Wavelength 
Range.  Click on the ‘Live Mode’ button to 
read the live signals.  Adjust the PMT HV to 
give signals between 0.5 and 8 V.  Move the 
polarizers into all possible positions to be 
sure that the signal stays below 10 V.  

iv. Click on ‘G-factor’ to collect a G-factor 
or enter a new one.  If the polarizers are 
controlled manually, follow the instructions 
for moving the polarizers. 

v. Click on the ‘Collect Data’ button to 
begin data collection.  If the polarizers 
are to be moved manually, a message 
will appear each time a polarizer is to be 
moved.  Automated polarizers will move 
automatically, and by default a message 
will be displayed as an indicator of the 
movement.  These messages are optional 
and may be removed by accessing the 
administration screen by simultaneously 
pressing ‘ctrl + shift + alt + a.’  Click on each 
polarizer node and find the parameter called 
‘NotifyUserOfMovement.’  Change this value 
to a 1 on each polarizer, press enter, and 
exit the administration screen. 

vi. For L-format measurements, a message will 
appear after each collection asking if the 
raw data are to be posted to Globalworks.  
This dataset will be posted as an individual 
dataset in addition to the final calculated 
dataset. 

vii. Click ‘yes’ to the question of posting the 
dataset to GlobalWorks.  

j. Activating NIR Detectors

i. On the Parameters page, locate the DC 
Devices frame, and uncheck the current 
active detectors.
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ii. Check the InGaAs detectors to activate 
them.

iii. On the Operational Modes page, ensure the 
desired Data Reduction Mode is active 

iv. Note there are no software gain controls 
for InGaAs detectors.  However, there may 
be a hardware switch on the detector.  The 
recorded signal should not exceed 10 V.

k. Automatically opening shutters for Live Mode 
and Data Collection

i. Click on the Close When Idle option of the 
shutter control on the Live Display page for 
each shutter that is intended to open only 
during data collection. 

ii. All shutters with this box checked will 
automatically open when Collect Data or 
Live Mode buttons are clicked, and close 
when these modes are exited.  Shutters 
will not automatically close between scans 
unless specified on the Operational Modes 
page.

l. Automatically closing the shutters between 
multiple scans

i. On the Repeated Scans page, enter the 
Number of Scans, Scans as a function of…., 
and the Total Scan Time (if applicable).  

ii. On the Operational Modes page, click on the 
checkbox labeled Close Shutters Between 
Repeated Scans.

m. Determine the calibration wavelength for the 
emission monochromator

i. Open the sample chamber lid and use a 
piece of white paper to reflect light into the 
emission monochromator.  This uses the 
highly common mercury lines present in 
most overhead fluorescent lights.  Some 
SLM instruments are equipped with 
automatic shutters, which close when the 
lid is lifted.  These must be disabled by 
disconnecting the ‘shutters’ cable from the 
back of the control box.

ii. Set the emission and excitation 
monochromator slits to a bandwidth of 0.5 to 
2.0 nm.

iii. On the Live Display page, enter ‘400’ as 
the Number of Increments, ‘0.5’ as the 
Integration Time, and 350 nm as both 
the Emission To and Emission From 
wavelengths.  Set the Excitation Scan Range 
as 300 nm to 400 nm.  Set the PMT HV to 
500 V 
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iv. Click on ‘Collect Data’ to begin scanning.  

v. Click ‘Yes’ to post data to GlobalWorks.  

vi. The scan should contain a single peak at 
the emission wavelength (350 nm).  Adjust 
the PMT HV and repeat the scan if the peak 
height is not in the proper range (0.1 V to 9 
V).  Click on the dataset and drag the cursor 
to peak maximum.  This should be 350 nm.  
Note the difference between the actual peak 
position and the expected peak position. 

vii. Simultaneously press ‘ctrl + shift + alt + a’ to 
access the administration screen.  Click on 
the Excitation Monochromator and find the 
Calibration Wavelength parameter.  Change 
this wavelength by the difference between 
the expected and actual wavelength noted in 
the above step.  Note, that if the wavelength 
needs to be increased (actual wavelength 
is less than expected) the calibration 
wavelength must be decreased.

viii. On the Parameters page, click on ‘Hardware 
Reset and Calibration.’  The instrument will 
go through the initial startup procedure.  

ix. Repeat the excitation scan and re-evaluate 
the peak

n. Determining the calibration wavelength for 
the excitation monochromator

i. Ensure that the emission monochromator 
has been properly calibrated.  See the 
procedure above for this calibration.  Place a 
scattering sample in the cuvette holder.

ii. Set the emission and excitation 
monochromator slits to a bandwidth of 0.5 to 
2.0 nm.

Fluorescence-Specific Procedures



41

iii. On the Live Display page, enter ‘400’ as the 
Number of Increments, ‘0.5’ as the Integration 
Time, and 350 nm as both the Emission To 
and Emission From wavelengths.  Set the 
Excitation Scan Range as 300 nm to 400 nm.  
Enter 800 V as the PMT HV. 

iv. Click on ‘Collect Data’ to begin scanning.  
Click ‘Yes’ to post data to GlobalWorks.  The 
scan should contain a single peak at the 
emission wavelength (350 nm).  Adjust the 
PMT HV and repeat the scan if necessary 
(Peak height is not between 0.1 and 9 V).  
Click on the dataset and drag the cursor to 
peak maximum.  This should be 350 nm.  
Note the difference between the actual peak 
position and the expected peak position.  

v. Simultaneously press ‘ctrl + shift + alt + a’ to 
access the administration screen.  Click on the 
Excitation Monochromator and find the Calibration 
Wavelength parameter.  Change this wavelength 
by the difference between the expected and actual 
wavelength noted in the above step.  Note, that 
if the wavelength needs to be increased (actual 
wavelength is less than expected) the calibration 
wavelength must be decreased. 

vi. On the Parameters page, click on ‘Hardware 
Reset and Calibration.’  The instrument will 
go through the initial startup procedure.  

vii. Repeat the excitation scan and re-evaluate 
the peak position.  Change the Calibration 
wavelength if necessary.

o. Generating an emission correction file using 
a standard lamp

i. Information on collecting a correction file 
is located in Principles of Fluorescence 
Spectroscopy by J. R. Lakowicz, 1999, 
Kluwer/Plenum Publishing.  

ii. Obtain a standard lamp which covers the 
wavelength range to correct.  Set up the 
lamp as described by the lamp manufacturer.  
Collect a spectrum over the desired 
wavelength range.  Note that the spectra will 
be later normalized so the absolute intensity 
of this spectrum is not important.

iii. Click ‘Yes’ to post the data to GlobalWorks.  

iv. Right-click on the newly created icon in the 
Experiment Window, and choose Select from 
the resulting menu.  A red checkmark will 
appear on the dataset icon. 
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v. Right-click on the icon again and choose 
Normalize from the Data Process list.  A 
new dataset will be created in which the 
entire dataset has been divided by the peak 
maximum intensity.  The maximum intensity 
will be 1. 

vi. Right-click on the dataset icon again, and 
choose De-select all from the menu.

vii. Open the standard spectrum provided with 
lamp.  This can be formatted into a two 
column text file and opened directly into Olis 
GlobalWorks.  See the Olis GlobalWorks 
manual for a description of importing 
datasets.  

viii. Right-click on the newly created icon in the 
Experiment Window.  Choose Select.  A red 
checkmark will appear on the dataset icon.

ix. Right-click on the normalized dataset 
created earlier, and choose Select.  A red 
checkmark will appear on this dataset icon.

x. Right-click on either of these dataset icons, 
and choose ‘Divide Selected datasets’ from 
the Data Process menu.  A new dataset will 
be created which is the ratio of the corrected 
to the actual measured spectra.

xi. On the File menu select ‘Save Dataset as’ 
and enter a valid Windows filename.  This is 
the correction file, and is applicable to any 
scan within this wavelength range.

p. Generating an emission correction file using 
a standard sample

i. The folder c:\Program Files\OLIS 
GlobalWorks\Demo Data\Fluorescence 
contains standard fluorescence scans, 
which have been collected with great care to 
correct for any instrument artifacts.

ii. Obtain a sample of a standard which covers 
the wavelength range to correct.  Collect a 
spectrum as described in the comments.  
Note that the spectra will be later normalized 
so the absolute intensity of this spectrum is 
not important.

iii. Click ‘Yes’ to post the data to GlobalWorks.  
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iv. Right-click on the newly created icon in the 
Experiment Window, and choose Select from 
the resulting menu.  A red checkmark will 
appear on the dataset icon. 

v. Right-click on the icon again and choose 
Normalize from the Data Process list.  A 
new dataset will be created in which the 
entire dataset has been divided by the peak 
maximum intensity.  The maximum intensity 
will be 1. 

vi. Right-click on the dataset icon again, and 
choose De-select all from the menu.

vii. Open the appropriate standard dataset.  
Right-click on the newly created icon in the 
Experiment Window.  Choose Select.  A red 
checkmark will appear on the dataset icon.

viii. Right-click on the normalized dataset 
created earlier, and choose Select.  A red 
checkmark will appear on this dataset icon.

ix. Right-click on either of these dataset icons, 
and choose ‘Divide Selected datasets’ from 
the Data Process menu.  A new dataset will 
be created which is the ratio of the corrected 
to the actual measured spectra.

x. On the File menu select ‘Save Dataset as’ 
and enter a valid Windows filename.  This is 
the correction file, and is applicable to any 
scan within this wavelength range. 

q. Correcting an emission scan

i. Right-click on the dataset associated with the 
dataset in the Experiment Window.  Choose 
Select from the resulting menu.  A red 
checkmark will appear on the dataset icon.
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ii. Right-click on the icon again and choose 
‘Correct Fluorescence Scan.’  A dataset 
containing a corrected emission scan will be 
created. 

r. Collecting a synchronous scan

i. On the Live Display page, enter the number 
of increments, integration time, and PMT HV 
(if using a PMT) for the scan. 

ii. Set the scan range of both the excitation and 
emission monochromators to the identical 
range.  Note, that the excitation wavelength 
will be plotted but both monochromators will 
be scanning.

iii. Click Collect data to begin the scan.  

6. Accessories

a. Temperature Controller (Julabo or Neslab 
water bath or Quantum Northwest Peltier)

i. General Description of the temperature 
controller

1. Olis instruments may be equipped 
with either a water bath or a Peltier 
thermoelectric cell.  Both of these are 
typically controlled by the software, but 
there are a few instruments equipped 
with an analog water bath with software 
control.

2. A water bath is typically manufactured 
by Julabo, although a few Neslab water 
baths are used for this purpose as 
well.  The water bath is connected to 
the computer through a serial port and 
controlled remotely by the computer.  
The circulating fluid (usually a mixture 
of ethylene glycol and water) is pumped 
through the cuvette holder to maintain 
the desired sample temperature.  An 
external probe is often used to monitor 
this temperature.  This connects to from 
the water bath and is mounted in the cell 
holder.  The set temperature is always 
the bath temperature, however.

3. The Peltier cells and controllers are 
manufactured by Quantum Northwest 
and allow for quick precise temperature 
control.  The Peltier cell does require 
the heat exchange pump to be running 
whenever this device is turned on.  
The unit uses a thermoelectric cell to 
regulate the temperature of the cuvette 
block.  An external probe is available in 
instruments produced after 2006.

4. Control of both types of temperature 
controllers is achieved through the 
Temperature Controller page or the 
use of a temperature script.  Both are 
described in detail later.

Accessories



45

b. Temperature Controller

i. Provides software control for Olis-compatible 
temperature controllers.

 Temperature Controller Type
 If the instrument is equipped with more 

than one type of temperature controller, the 
active temperature controller is chosen here. 
The current choices possible are Quantum 
(Peltier controlled cell) and Julabo (water 
bath). Only one choice will be available if the 
instrument is only equipped with one.

 Sample Holder Temperature
 This is the current reading of the sample 

holder and is only updated if the instrument 
is in Live Mode. With the Peltier (Quantum 
Northwest) this temperature represents than 
inside the cell holder. In the case of the 
water bath (Julabo), this temperature is the 
temperature of the bath.

 See page 8 for more information about Live 
Mode.

Has External Probe
 This checkbox indicates whether the 

temperature controller is equipped with an 
external temperature probe. This probe 
would be inserted into the cuvette holder, 
or into the sample itself, to give a more 
accurate temperature reading of the sample. 
An additional field will report the probe 
temperature.

On/Off
 This switch controls whether the temperature 

controller is active. If Off is selected, no 
communication will be attempted between 
the software and the temperature controller. 
If On is selected the temperature controller 
unit must be on, or errors will result.

 Set Temperature
 This is where the set point temperature 

on the bath or Peltier cell is set. The 
temperature should immediately approach 
this value if the controller is active. The 
only time this is not the set point is when a 
temperature script is being run.

Window of tolerance
 The window of tolerance is the range 

of temperatures in which the current of temperatures in which the current of
temperature is equal to the set point 
temperature. For example, if during the 
running of a temperature script with the 
current temp set at 40°C and a window of 
tolerance of ±1°C, the set temperature will 
be achieved when the current temperature 
reaches 39-41°C. The actual temperature, 
however, will be recorded with the data.

Temperature Units
Only Celsius units are available.
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ii. Activating the temperature controller

1. Ensure the Julabo water bath or 
Quantum Northwest Peltier control box is 
plugged into the proper communications 
port and is turned on.  Note the heat 
exchange system must be operating 
prior to turning the Quantum Northwest 
control box on.

2. On the Temp Controller page click on the 
‘On’ button to establish communication 
with the water bath.

3. Enter the set temperature.

iii. Setting the current temperature

1. On the Temp Controller page ensure that 
the on ‘On’ button is selected.

2. Enter the set temperature.

iv. Changing the temperature tolerance

1. On the Temperature Controller page 
enter the temperature tolerance.  This 
number is typically between 0.1 and 1 
degree C.

v. Using an external temperature probe

1. Ensure the external temperature probe 
is connected to the water bath.

2. On the Temperature Controller page 
click on the Has External Probe 
checkbox.  The bath temperature will 
continue to the set temperature.  The 
reported temperature will be that of the 
probe.

vi. Using a temperature script

1. On the Repeated Scans page, choose 
Repeated Scans as a function of 
‘Temperature Script.’ 

2. Ensure that the selected temperature 
script is correct.  If not, click on the 
Browse button and browse to the correct 
script.  The file extension of Olis Scripts 
is osf. 

3. To print or edit the script, click on the 
‘Edit/Print Script’ button.  Make changes 
to the script and choose Save from 
the File menu.  Details about the script 
format are located in Appendix III.

4. On the Live Display page, set the Scan 
Range and integration time for each 
scan to be collected.  If a data at a 
single wavelength is to be collected.  
Choose the Assay mode as the Data 
Collection Mode.  Choose the Assay 
Wavelength on the Live Display page.  
Press Collect Data to begin collecting 
scans.  The temperature will ramp to the 
scripted temperature prior to each scan.  
After the temperature has been reached, 
the instrument will wait for the scripted 
incubation time prior to measurement.  
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vii. Changing the temperature controller com 
port

1. In the Live Display page, simultaneously 
press ctrl+shift+alt+a to access the 
Administration screen. 

2. Click on the Julabo Water bath or 
Quantum Northwest Peltier Controller 
node and locate the Com Port 
parameter. 

3. Change this parameter to the new Com 
port.  Close the Administration screen.

4. On the Parameters page, click on the 
‘Hardware Reset and Calibration.’  

b. Sample changer

 A variety of sample changers are available 
including water jacketed or Peltier temperature 
controlled.  All are software controlled.

i. General Description of Sample Changers

1. Olis provides a variety of sample changers 
with our instruments.  These allow 
for measurement of several samples 
with minimal user input.  Some are 
manufactured at Olis and some are third 
party manufacturers.  Many of the Peltier 
controlled cell holders are also cell changers.

2. Control of the cell changers is 
accomplished by a control on the Live 
Display page.  In addition, there is an 
option to automatically cycle the cell 
position on the Repeated Scans page.

ii. Calibrating the sample changer

1. On the Parameters page click on the 
Hardware Reset and Calibration button.  
This will reinitiate the startup procedure for 
the instrument including the sample changer. 

2. Alternatively, a Quantum Northwest 
Peltier controlled turret may be 
recalibrated by pressing and holding one 
of the numbered position buttons on the 
Quantum Northwest control box.

iii. Changing the current sample position

1. On the Live Display page, click on the 
Sample Position list box and select the 
desired position for the sample changer. 
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iv. Collecting multiple scans automatically using 
different sample positions.

1. On the Live Display page enter the 
desired wavelength range.

2. Set the Number of Scans on the 
Repeated Scans page to the desired 
number.  Note that this is the number 
of scans for each position, not the total 
number of scans to be collected.

3. Click the Cycle Scans checkbox on the 
Repeated Scans page.  This indicates 
that the software will change the sample 
changer position after each scan.  

4. Enter the number of cells to cycle 
through in the text box to the right of 
the Cycle Cells checkbox.  This will 
determine the number of cells used in 
the experiment.  For example selecting 
‘3’ will result in scans of samples 1, 
2 and 3.  Cells higher than 3 will be 
ignored.

v. Collecting an Assay using multiple cell 
positions

1. On the Live Display page enter the 
desired wavelength range.

2. Set the Number of Scans on the 
Repeated Scans page to the desired 
number.  Note that this is the number 
of scans for each position, not the total 
number of scans to be collected.

3. Click the Cycle Scans checkbox on the 
Repeated Scans page.  This indicates 
that the software will change the sample 
changer position after each scan.  

4. Enter the number of cells to cycle 
through in the text box to the right of 
the Cycle Cells checkbox.  This will 
determine the number of cells used in 
the experiment.  For example selecting 
‘3’ will result in scans of samples 1, 
2 and 3.  Cells higher than 3 will be 
ignored.

5. After the datasets have been collected, 
click on the desired dataset and choose 
Create a Data Subset from the Tools 
menu.  Enter the desired wavelength 
to extract as the wavelength range and 
click ok.  A dataset containing data 
only at the desired wavelength will be 
created. 

c. Stopped flow accessory

i. General description of the stopped flow

1. The stopped flow is a mixing device in 
which two or more reagents are rapidly 
mixed into a cell.  The cell is mounted 
in the sample chamber so the excitation 
beam strikes the mixed solution.  
Fluorescence or other measurements 
are made subsequently to this solution 
as it ages.

2. The Olis stopped flow is typically 
mounted on the top of the sample 
chamber and the observation cell hangs 
into the sample chamber and replaces 
the sample holder in the chamber.  This 
sample holder needs to be removed 
prior to installation of the stopped flow.

3. The reagents are loaded into the drive 
syringes by opening moving the Fill/Flow 
valves to the Fill position.  The valves 
should be moved to the Flow position 
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for stopped flow operation.  During the 
stopped flow shot, the reagents are 
pushed through a Berger-Ball mixer 
into the observation cell.  The previous 
contents of the cell are pushed into the 
stop syringe.  When the stop syringe 
fills the flow is stopped and the reaction 
begins.  This point is designated as time 
zero in the Olis dataset.

4. The stopped flow is triggered by 
SpectralWorks, but requires manual 
movement of the valves and syringes 
between stopped flow shots.  The mixing 
is accomplished by introducing gas 
pressure of 75-90 psi to the piston by 
opening of a solenoid valve.

5. After data collection, the stop syringe 
must be emptied prior to the next 
stopped flow shot.  This is accomplished 
by moving the exhaust valve to the 
Empty position and pushing down on the 
stop syringe.  The contents of the stop 
syringe will be pushed into the waste 
syringe.

ii. Collecting stopped flow data

1. On the Operational Modes page select 
the Data Collection Mode as either 
‘Stopped Flow’ for single wavelength 
data collection.

2. The stopped flow possesses six sensors 
which all must be in the correct positions 
before the stopped flow will fire.  These 
are the Front and Back Syringes (FS 
and BS), Front and Back Handles (FH 
and BH), exhaust handle (EH), and the 
Stop Syringe (SS).

3. To determine the if the stopped flow 
sensors are in the correct position, click 
on Live Mode.  The color of the Collect 
Data button will indicate the condition 
of the sensors.  A red button indicates 
a valve or sensor out of position.  The 
color will only be updated in Live Mode.  

4. A map of the sensors is shown on the 
Parameters page.

5. To collect stopped flow data.  Choose 
the Collection Time, Wavelength (or 
Center Wavelength), and the Show Pre-
trigger Data Checkbox.  Click on Collect 
Data and press the space bar when 
prompted. 

iii. Showing pre-trigger data

1. A stopped flow trace is divided into a 
pre-trigger and post-trigger section.  The 
pre-trigger data are collected before 
the reagents have fully mixed, and is 
designated as negative time.  The post-
trigger region begins at the end of the 
reagent mixing, which is designated as 
time zero.
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2. The Live Display page contains the 
option to view this pre-trigger data.  
Check the Show Pre-Trigger Data 
checkbox to automatically include 
these data in the collected datasets.  
Unchecking the box, results in only 
post-trigger data being included in the 
dataset. 

3. Checking or unchecking the Show Pre-
Trigger checkbox after the data have 
been collected will result in posting of 
the respective datasets to GlobalWorks.

iv. Changing the rate of data averaging

1. For single wavelength stopped flow 
data collection, the averaging mode of 
the software collection is automatically 
determined by the software.  This 
averaging rate is calculated using the 
Data Collection Time and the number of 
points to collect. 

v. Changing the stop time adjustment

1. Time zero is determined in the software 
by adding an adjustment factor (Stop 
Time Adjust) to the time in which the 
stop syringe is detected to have passed 
into the ‘up’ position.  The Stop Time 
Adjust can be adjusted to correctly 
determine time zero.

2. To check the stop time adjustment, set 
up a relatively fast stopped flow reaction.  
The N-acetyl tryptophanamide (NATA) 
reaction with N-bromosuccinimide 
(NATA) described in Appendix 4 serves 
as an excellent test reaction for this 
purpose.

3. Collect a stopped flow trace with the 
Show Pre-Trigger Data checkbox 
checked. 

4. Click on the dataset and determine the time 
of the point in which the reaction begins.  
For the NATA reaction, this is point just as 
the exponential decay begins.  This time is 
the amount that the Stop Adjust Time needs 
to be adjusted.  If this is zero, then this 
parameter does not need to be adjusted. 

5. To adjust the stop adjust parameter, 
simultaneously press ctrl+shift+alt+a to 
access the administration screen.  

6. Find the A/D section of the administration 
screen.  This may contain the word Datel, 
GaGe, or Bitwise.  Click on this node 
to open it.  Locate the parameter called 
StopTimeAdjust.  This value has units of 
milliseconds.  Add the time measured for 
the beginning of the stopped flow trace 
to this value.  Note this time may have 
been negative.  Press enter and close the 
administration screen.
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7. Repeat the stopped flow shot and repeat 
the adjustment if necessary.

vi. Changing the number of data points

1. When collecting stopped flow data at a 
single wavelength the number of data 
points in the dataset is typically fixed to 
1000.  Note that the number of scans 
collected in the rapid scanning mode 
of RSM is determined by the averaging 
mode and the data collection time.

2. To change the dafault number of single 
wavelength stopped flow data points, 
simultaneously press ctrl+shift+alt+a to 
access the administration screen.

3. Locate the A/D node from the those 
listed on the administration screen.  This 
will have the label GaGe, Datel, or Bit-
wise.  Click on this node to open it. 

4. Locate the parameter called 
NumberOfSFPoints.  Click on the 
parameter and change it to the desired 
number of points.  Press enter and close 
the administration screen.

vii. Digital filtering (RC Filter) of time data

1. Application of a digital RC filter can be 
achieved by clicking on the Apply RC 
Filter checkbox.

2. On the Live Display page, click on 
the checkbox labeled Apply RC Filter.  
Choose the appropriate strength of 
the filter in the list box next to the RC 
Filter control.  The units of this value 
is milliseconds.  It is advisable for this 
value not to exceed 5% of the total time 
of data collection.

d. Titrator

i. General description of titrator

1. The Olis titrator consists of two to four 
motor-driven syringes connected to a 
flow cell inside the sample chamber.  
One of the syringes is designated in 
the software as the sample syringe.  
The sample to be measured is loaded 
into this syringe and the titrant(s) in the 
other syringe(s).  During the titration 
a specified volume form the titrant 
syringe(s) is added to the cell containing 
the contents of the sample syringe.  The 
sample is mixed by drawing the sample 
into the sample syringe, and pushed 
into the cuvette for measurement.  All of 
the titrator controls, except movement 
of the valves, is controlled through the 
software.
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2. The titrator may consist of two, three, 
or four syringes.  The four syringe 
titrator allows addition of up to three 
different titrants for each measurement.  
Temperature control using Peltier cells 
is also available.  The default is ambient 
temperature.

3. The titrator is activated by selecting 
Repeated Scans as a Function of 
Titrator Script.  The titrator will be 
subsequently calibrated.  A message 
will appear indicating that reservoir 
syringes containing solvent or buffer 
should be connected and the Fill/Flow 
valves should be in the Fill position.  At 
this point the syringes will fill to a home 
position and return to empty. 

4. The titrant addition volumes, number 
of mix cycles, and incubation time 
after each mix are specified by a script 
file.  The details of the script file format 
are described in Appendix III.  Data 
collection will begin automatically after 
each addition and incubation time, and 
collection parameters are given on the 
Live Display page.

5. The volume resolution is limited by the 
volume of the syringe (0.5 mL to 10 
mL) and the number of motor steps in 
traversing the syringe (10,000).  Thus 
the volume resolution ranges from 0.05 
µL/step to 1 µL/step.

ii. Manual control functions
Allows for software controll of the Olis 
titrator. Access to this screen is in the 
Repeated Scans tab.

 Script File
 This designates the current script file name. 

It is identical to that shown in the Repeated 
Scans tab.

Execute Line
 Click on this button to execute a line of the 

script without collecting data. The software
will prompt for which line to execute. The 
syringes will move, but no data will be 
collected.

Execute Script
 Click on this button to execute an entire 

script without collecting data. The syringes
will move, but no data will be collected.
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 Select Script
 This button allows the user to select a valid 

titration script. Changes in the script in this 
window will change it in the others as well.

View/Print ScriptView/Print ScriptView
 This button allows the user to open the script 

for editing or printing. Note: Do not attempt 
to change the “Default Titrator.osf” script as 
it is a read only file and is necessary as a 
backup script file.

Com Port Number
 Ensure that this number matches the com 

port number that the titrator is actually using.

Syringe Size (uL)
 Ensure that the syringe size in this display

matches the actual syringe size for the 
selected syringe.

 To select a syringe, click on the desired 
syringe in Syringe Control. The text box 
below the syringe will become yellow, 
indicating it has been selected. Changing 
the syringe size changes the size of only the 
selected syringe.

 Syringes are selected using the Syringe 
Control.

 Calibrate Syringe
 These buttons initiate a calibration 

procedure. During calibration, the syringe 
fills completely until a sensor is reached, 
whereupon the syringes empty. It is 
important to have the valve in “Fill” position 
and have enough sample in the fill syringe. 
If samples are precious, it is important that 
calibration is done using water or buffer.

Calibrate Selected only calibrates the 
selected syringe, while Calibrate All initiates 
the calibration procedure for all syringes.

 Syringes are selected using the Syringe 
Control.

 The keystroke shortcuts for Calibrate 
Selected and Calibrate all are S and A, 
respectively.

 Park Syringe
 When one of these buttons is pressed, on 

or more of the syringes fills or empties to 
half full.

Park Selected parks only the selected 
syringe, while Park All moves all of them.

 Syringes are selected using the Syringe 
Control.

Rinse Syringe
 Rinsing syringes involves alternating filling 

and emptying them. When clicking on of 
these buttons, the software will prompt to 
ask the number of desired rinses (1-99). It number of desired rinses (1-99). It number is 
important to have the valve in “Fill” position 
and have enough sample in the fill syringe.  
If samples are precious, it is important that 
calibration is done using water or buffer.

Rinse Selected rinses only the selected 
syringe, while Rinse All initiates the 
procedure for all of them.

 Syringes are selected using the Syringe 
Control.

 The keystroke shortcuts for Rince Selected 
and Rinse all are R and N, respectively.
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Fill Syringe
 These buttons cause syringes to completely 

fill. It is important to have the valve in “Fill” 
position and have enough sample in the 
fill syringe. If samples are precious, it is 
important that calibration is done using water 
or buffer.

Fill Selected rinses only the selected 
syringe, while Fill All initiates the procedure 
for all of them.

 Syringes are selected using the Syringe 
Control.

 Empty Syringe
 These buttons cause syringes to completely 

empty. It is important to have the valve in 
the desired position so the contents of the 
syringe are not inappropriately expelled. If 
samples are precious, it is important that 
calibration is done using water or buffer.

 Empty Selected rinses only the selected 
syringe, while Empty All initiates the 
procedure for all of them.

Syringe Control
 This control allows the user to manually 

manipulate the syringe volume. The current 
volume is displayed in the box at the bottom 
of each virtual syringe. This volume can be 
changed by entering in a new value (in uL) 
or dragging the sidebar control to the desired 
approximate volume. Filling of the syringe is 
graphically illustrated by the blue shading. 
To select a syringe, click on the body of the 
syringe. A yellow text box will indicate that 
the syringe is selected.

iii. Filling and rinsing syringes

1. On the Repeated Scans Page click 
on the ‘Show Manual Control Form’ 
button.  If this button is not active, 
select Repeated Scans as a Function of 
…Titrator Script to activate the titrator.  

2. Ensure both fill valves are in the Fill 
position and ensure that enough liquid 
is present in the reservoir syringes to fill 
each drive syringe half way.

3. Click on the desired syringe to highlight 
it.  Fill the syringe by dragging the cursor 
for the syringe.  Alternatively, the new 
volume can be entered in the text box 
associated with the syringe.

4. To rinse the syringe, click on the Rinse 
Selected button and enter the number 
of rinses.  The syringe will repeatedly 
empty and fill one plus the number of 
extra rinses requested.

iv. Creating a titrator script

1. Use Windows Explorer to browse to 
c:\Program Files\OLIS GlobalWorks\
Utilities folder and find the Script Editor.
exe program.  There is also a help file in 
the folder entitled Script Editor Help.doc.
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2. Double click the Script Editor program 
and click on the Titrator Script tab.  

3. Click on Generate Script.  Choose the 
two syringe, three syringe (constant 
sample), or four syringe.  Enter the 
desired volumes to be included in the 
script.  Enter the number of mixes and 
incubation times.  Click OK. 
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4. Enter the Syringe Fill Volumes and Mix 
Fill Percentage, and Cuvette volume.  
See the help file in the c:\Program 
Files\OLIS GlobalWorks\Utilities for 
descriptions of these parameters.

5. Click on Check Script Volumes.

6. Choose Save As… from the File menu.  
Choose this file when running the 
titration script. 

7. Close the Script Editor program.
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v. Running a titrator script

1. On the Repeated Scans page, ensure 
the Repeat Scans as a function of ….  is 
set to Titration Script.  This will activate 
the titrator. 

2. Click on Browse and point to the desired 
titration script.  Olis script files use the 
file extension .osf.  

3. On the Live Display page enter the 
desired wavelength Scan Range, 
Number of Increments, and Integration 
time.

4. Click on Collect Data.  

vi. Removing air bubbles from the syringes

1. On the Repeated Scans Page click on 
the ‘Show Manual Control Form’ button 
to open this form.

2. Ensure both fill valves are in the Fill 
position and ensure that enough liquid 
is present in the reservoir syringes to fill 
each drive syringe half way.

3. Click on the Park All button.

4. Remove the thumb screw connecting 
the syringe plunger to the motor 
bracket.  Empty and fill the syringe by 
hand repeatedly until all bubbles have 
been forced into the reservoir syringes.  
Replace the thumb screw.

5. Click on Empty All to empty the syringes.

6. Close the Manual Control Form after the 
syringes have emptied.

e. Enzyme Assay Device

i. General Description of the Enzyme Assay 
Device

1. The enzyme assay device is a 
modification of the Olis titrator.  This 
device typically consists of four syringes 
each which passes though a mixer to 
a flow cell.  The cell is located in the 
sample chamber of the fluorometer.  
The enzyme assay device operates 
differently from the titrator in that the 
volume specified are always pushed 
into the cell.  No sample syringe is 
designated.

2. The option of syringe temperature 
control is available through use of a 
Peltier controller.  Typically, one syringe 
is kept in separate control as the others 
allowing the enzyme to be stored at a 
different temperature than the assay 
temperature.

3. The Enzyme Assay Device is activated 
by selecting Repeated Scans as a 
Function of Enzyme Assay Script.  The 
device will be subsequently calibrated.  
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A message will appear indicating that 
reservoir syringes containing solvent or 
buffer should be connected and the Fill/
Flow valves should be in the Fill position.  
At this point the syringes will fill to a 
home position and return to empty.

4. The reagent addition volumes, number 
of mix cycles, and incubation time 
after each mix are specified by a script 
file.  The details of the script file format 
are described in Appendix III.  Data 
collection will begin automatically after 
each addition and incubation time, and 
collection parameters are given on the 
Live Display page.

5. The volume resolution is limited by the 
volume of the syringe (0.5 mL to 10 
mL) and the number of motor steps in 
traversing the syringe (10,000).  Thus 
the volume resolution ranges from 0.05 
µL/step to 1 µL/step.
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ii. Manual control functions
Allows for software controll of the Olis 
titrator. Access to this screen is in the 
Repeated Scans tab.

 Script File
 This designates the current script file name. 

It is identical to that shown in the Repeated 
Scans tab.

Execute Line
 Click on this button to execute a line of the 

script without collecting data. The software
will prompt for which line to execute. The 
syringes will move, but no data will be 
collected.

Execute Script
 Click on this button to execute an entire 

script without collecting data. The syringes
will move, but no data will be collected.

 Select Script
 This button allows the user to select a valid 

titration script. Changes in the script in this 
window will change it in the others as well.

View/Print ScriptView/Print ScriptView
 This button allows the user to open the script 

for editing or printing. Note: Do not attempt 
to change the “Default Titrator.osf” script as 
it is a read only file and is necessary as a 
backup script file.

Com Port Number
 Ensure that this number matches the com 

port number that the titrator is actually using.

Syringe Size (uL)
 Ensure that the syringe size in this display

matches the actual syringe size for the 
selected syringe.

 To select a syringe, click on the desired 
syringe in Syringe Control. The text box 
below the syringe will become yellow, 
indicating it has been selected. Changing 
the syringe size changes the size of only the 
selected syringe.

 Syringes are selected using the Syringe 
Control.

 Calibrate Syringe
 These buttons initiate a calibration 

procedure. During calibration, the syringe 
fills completely until a sensor is reached, 
whereupon the syringes empty. It is 
important to have the valve in “Fill” position 
and have enough sample in the fill syringe. 
If samples are precious, it is important that 
calibration is done using water or buffer.
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Calibrate Selected only calibrates the 
selected syringe, while Calibrate All initiates 
the calibration procedure for all syringes.

 Syringes are selected using the Syringe 
Control.

 The keystroke shortcuts for Calibrate 
Selected and Calibrate all are S and A, 
respectively.

 Park Syringe
 When one of these buttons is pressed, on 

or more of the syringes fills or empties to 
half full.

Park Selected parks only the selected 
syringe, while Park All moves all of them.

 Syringes are selected using the Syringe 
Control.

Rinse Syringe
 Rinsing syringes involves alternating filling 

and emptying them. When clicking on of 
these buttons, the software will prompt to 
ask the number of desired rinses (1-99). It number of desired rinses (1-99). It number is 
important to have the valve in “Fill” position 
and have enough sample in the fill syringe.  
If samples are precious, it is important that 
calibration is done using water or buffer.

Rinse Selected rinses only the selected 
syringe, while Rinse All initiates the 
procedure for all of them.

 Syringes are selected using the Syringe 
Control.

 The keystroke shortcuts for Rince Selected 
and Rinse all are R and N, respectively.

 Fill Syringe
 These buttons cause syringes to completely 

fill. It is important to have the valve in “Fill” 
position and have enough sample in the 
fill syringe. If samples are precious, it is 
important that calibration is done using water 
or buffer.

Fill Selected rinses only the selected 
syringe, while Fill All initiates the procedure 
for all of them.

 Syringes are selected using the Syringe 
Control.

 Empty Syringe
 These buttons cause syringes to completely 

empty. It is important to have the valve in 
the desired position so the contents of the 
syringe are not inappropriately expelled. If 
samples are precious, it is important that 
calibration is done using water or buffer.

 Empty Selected rinses only the selected 
syringe, while Empty All initiates the 
procedure for all of them.

Syringe Control
 This control allows the user to manually 

manipulate the syringe volume. The current 
volume is displayed in the box at the bottom 
of each virtual syringe. This volume can be 
changed by entering in a new value (in uL) 
or dragging the sidebar control to the desired 
approximate volume. Filling of the syringe is 
graphically illustrated by the blue shading. 
To select a syringe, click on the body of the 
syringe. A yellow text box will indicate that 
the syringe is selected.
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iii. Filling and rinsing syringes

1. On the Repeated Scans Page click 
on the ‘Show Manual Control Form’ 
button.  If this button is not active, 
select Repeated Scans as a Function of 
…Titrator Script to activate the titrator.  

2. Ensure both fill valves are in the Fill 
position and ensure that enough liquid 
is present in the reservoir syringes to fill 
each drive syringe half way.

3. Click on the desired syringe to highlight 
it.  Fill the syringe by dragging the cursor 
for the syringe.  Alternatively, the new 
volume can be entered in the text box 
associated with the syringe.  

4. To rinse the syringe, click on the Rinse 
Selected button and enter the number 
of rinses.  The syringe will repeatedly 
empty and fill one plus the number of 
extra rinses requested.

iv. Running an enzyme assay script

1. On the Repeated Scans page, ensure 
the Repeat Scans as a function of ….  is 
set to Enzyme Assay Script.  This will 
activate the titrator. 

2. Click on Browse and point to the desired 
titration script.  Olis script files use the 
file extension .osf.

3. On the Live Display page enter the 
desired wavelength, Number of 
Increments, and Total Assay Time.  

4. Click on Collect Data.  

5. Press the space bar when prompted.

v. Removing air bubbles from the syringes

1. On the Repeated Scans Page click 
on the ‘Show Manual Control Form’ 
button.  If this button is not active, 
select Repeated Scans as a Function of 
…Titrator Script to activate the titrator.  
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2. Ensure both fill valves are in the Fill 
position and ensure that enough liquid 
is present in the reservoir syringes to fill 
each drive syringe half way.

3. Click on the Park All button. 

4. Remove the thumb screw connecting 
the syringe plunger to the motor 
bracket.  Empty and fill the syringe by 
hand repeatedly until all bubbles have 
been forced into the reservoir syringes.  
Replace the thumb screw.

5. Click on Empty All to empty the syringes.

6. Close the Manual Control Form after the 
syringes have emptied.

f. Sample Angle adjuster

i. General Description of the sample angle 
adjuster

1. Some Olis instruments are equipped 
with an automated sample angle 
adjuster.  This is a device which may 
be manufactured by Olis or a third party 
manufacturer.  The sample angle is set 
by the SpectralWorks, and Zero degrees 
is defined as being perpendicular to 
the exciting beam.  The 90° position is 
parallel.

2. The angle can be set using a control on 
the Live Display page or a sample angle 
script.  These are described in detail 
later.

ii. Adjusting the current sample angle

1. On the Live Display page, enter the 
desired angle in the Sample Angle 
text box.  Zero degrees is defined as 
the sample being perpendicular to the 
measuring beam.  The 90° position is 
parallel to the beam. 

iii. Calibrating the sample angle adjuster

1. On the Live Display page, click on the 
button labeled ‘Calib.’.  The sample 
holder will turn to the calibrate position 
and return to its previous value. 

2. Alternatively, the sample angle adjuster 
can be calibrated by clicking on the 
‘Hardware Reset and Calibration’ button 
on the Parameters page.  This will 
calibrate all motors on the instrument 
including the monochromator.

iv. Creating an angle script

1. Use Windows Explorer to browse to 
c:\Program Files\OLIS GlobalWorks\
Utilities folder and find the Script Editor.
exe program.  There is also a help file in 
the folder entitled Script Editor Help.doc.

2. Double click the Script Editor program 
and click on the Angle Script tab.
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3. Enter the Start Angle, Stop Angle, 
and Increment for the Script.  Click on 
Generate Script.

4. Choose Save As… from the File menu.  
Choose this file when running the angle 
script. 

5. Close the Script Editor program.

v. Running an angle script

1. On the Repeated Scans page, choose 
Repeated Scans as a function of … 
Angle Script.

2. Click on Browse and select an 
appropriate script.

3. On the Live Display screen set up the 
Scan Range, Number of Increments, and 
Integration Time (or Reads per Datum).  
Click Collect Data to start the scans.

g. Photon Counter

i. General Description of the photon counting 
module

1. The photon counting module contains 
a power supply, electronics and a 
photomultiplier tube.  This unit is 
connected to a serial connection on the 
computer.

2. There is no software control over the 
PMT HV as this is a hardware switch 
on the photon counter.  This must be on 
to operate the detector and must be off 
before exposing the detector to room light.

ii. Activating the photon counter

1. On the Parameters page uncheck and 
DC Devices that are not to be used.  
Click on PC1 (and PC2) to activate the 
photon counter(s).

2. On the Operational Modes page select 
the appropriate Data Reduction Mode.  
This mode is Photon Counting for one 
photon counter and Ratio for two photon 
counters. 

iii. Normalizing photon counter signals

1. If the Data Reduction Mode on the 
Operational Modes page is set to Photon 
Counting, a check box labeled Normalize 
Photon Counting. 
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2. Check the Normalize Photon Counting 
checkbox.  The photon counting signal 
will be reported in units of counts per 
second.  The raw signal counts will be 
divided by the integration time.

h. Automated shutters

i. Opening and closing the shutters

1. On the Live Display page, click on the 
shutter control.  Click ‘Open’ to open the 
shutter and ‘Close’ to close the shutter.  

ii. Automatically opening the shutters during 
data collection

1. Click on the checkbox labeled Close 
Slits When Idle.  The shutter will 
automatically open when the instrument 
enters Live Mode or Data Collection.

iii. Automatically closing the shutters between 
multiple scans

1. On the Operational Modes page, 
click on the Close Shutters between 
Repeated Scans checkbox.  Shutters will 
automatically be closed between scans 
when repeated scans are collected.
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Appendices

1. Administration Screen

i. General Description of the Administration 
Screen

1. The administration screen is used to 
edit parameters that are not available on 
the general software screens.  Most of 
these parameters will be of little interest, 
and many will cause catastrophic 
damage to the instrument if changed.  
Please use caution when changing any 
parameters in the Administration Screen.  
A parameter file stores these values and 
is located in the c:\Program Files\OLIS 
GlobalWorks\ParaXML directory.  It 
would be advisable to locate this file and 
store a backup in a secure location.

2. The administration screen is 
accessed by simultaneously pressing 
ctrl+shift+alt+a.  A screen will appear 
showing the individual components of 
the instrument.  These may or may 
not correspond directly to an actual 
hardware component.  Others are 
components of the software.

3. Clicking on one of the components will 
expand its parameter set and allow 
access to the parameters to be visible.  
To change a parameter, click on it, type 
in the new value, and press enter. 

4. The following table contains several 
parameters which may be of interest to 
adjust.  
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PARAMETER COMPONENT DEFAULT DESCRIPTION

AssayFlashPoint DCGUI 5 This parameter determines the data point in which the TTL flash 
trigger pulse occurs.  The instrument must be equipped with TTL 
hardware, which is usually associated with a flash lamp or laser.

DACScripting DCGUI 0 For instruments equipped with a PEM or LCVR polarization 
accessory, this parameter allows the instrument to collect data 
as a function of drive voltage sent to the PEM or LCVR.  This 
function is typically used for diagnostics.

MaxPointsToCollect DCGUI 5000 The maximum number of points allowed in a scan or an assay.  
This is limited to about 10000.

OverheadPercent DCGUI 25 The amount of time assigned to overhead during assigning of automatic 

SignificantDigits DCGUI 3 Number of significant digits past the decimal in the data 
reported on the Live Display page.

DaysToKeepSafeData DCGUI 30 The number of days before erasing backup data in the c:\
Program Files\OLIS GlobalWorks\SafeData folder.

ComPortNumber MCB 1 Com port in which the main control box is plugged into the computer.

DCTimeOut VintageAD 1 This parameter determines the amount of time before posting 
an error message after no communication is received from the 
A/D board.  This parameter is multiplied by the integration time 
to calculate the wait time.

CalibrationWavelength Mono 0 (-15 for 
SLM)

Wavelength assigned to the home position of the 
monochromator.  The apparent wavelength will be shifted by 
changing this value. 

MinHighVoltage PMT 200 Lowest possible HV setting for operation the PMT.  Occasionally 
one may want to measure data with no PMT gain (HV=0)

NotifyUserOfMotion Polarizer True By default, a message will appear every time one the polarizers 
are moved.  Setting this to false will avoid these messages.

ComPortNumber PC1 3 The serial port into which the photon counting module is 
plugged in.  This must be different from the electronics box and 
any other accessories.

Size (syringe) ENZASSAY 2500 Size (µL) of syringe in the enzyme assay device.

Size (syringe) Titrator 2500 Size (µL) of syringe in the titrator.

ComPortNumber ENZ MCB 3 Serial port into which the enzyme assay device is plugged into.  
Must be different from electronics box and other accessories, 
but may be the same as titrator.

ComPortNumber Titrator MCB 3 Serial port into which the enzyme assay device is plugged into.  
Must be different from electronics box and other accessories, 
but may be the same as the enzyme assay device.

TriggerOverhead Stopped Flow 150 Amount of time (milleseconds) assigned to allocated for 
collection of pre-trigger data.  If this time is not large enough, 
the number of data points in the post-trigger dataset will be less 
than stated in NumberOfSFDataPoints

NumberOfPointsOfSFData GaGe or 
BitWise AD

1000 The number of points assigned for post-trigger stopped flow 
data.  The dataset should contain this many data points starting 
at time zero, and is limited to about 10000.

SignificantDigits GaGe, BitWise, 
or Vintage AD

3 Number of significant digits past the decimal in the data 
reported on the Live Display page.

StopAdjustTime GaGe or 
BitWise

5-10 Applicable only to stopped flow.  The time zero adjustment from 
recording of the stop syringe.  This number should be adjusted 
so that the reaction starts at time zero.

ComPortNumber Julabo, Neslab, 
or Quantum

3 The serial port in which the temperature controller is plugged 
into the computer.  This must be different from the electronics 
box or other accessories.

TurnOnAtBeginning Julabo, Neslab, 
or Quantum

False Determines whether the temperature controller is automatically 
turned on when the instrument is started.

SequentialReads* Julabo, Neslab, 
or Quantum

3 Number of consecutive temperature reads within the specified 
range required before script incubation time begins.  If this 
number is too low, incubation will start during the ‘overshoot’ of 
the Peltier controller.

Table of Parameters
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2. Polarization Equations

i. PEM/LCVR Polarization of fluorescence

1. Summary of the technique

a. Uses a traditional L-format 
polarization set up with two 
polarizers, one on the excitation 
beam and the other before the 
detector.  In addition, a photoelastic 
modulator (PEM) or liquid crystal 
variable retarder (LCVR) is placed 
between the sample and the 
emission polarizer.  The excitation 
polarizer is fixed in the vertical 
position and the emission polarizer 
in the horizontal position.  No G-
factor is required for collection of 
anisotropy or polarization data.

2. Measurement of POF data

a. The horizontally polarized emission 
intensity (I⊥) is measured using the 
PEM or LCVR off.  In this case the 
excitation polarizer is vertical and the 
emission is horizontal.  To measure 
vertically polarized emission (Iǁ), 
the PEM or LCVR is turned on 

ǁ
the PEM or LCVR is turned on 

ǁ

and rotates the polarization of the 
emitted light by 90°, thus rotating 
the vertical emission to horizontal.  
The measured horizontal polarized 
intensity is Iǁ.

b. The software switches the 
measurement from I⊥ to Iǁ at a 
rate of five per second (LCVR) or 

ǁ
rate of five per second (LCVR) or 

ǁ

1000 per second (PEM).  Iǁ / I⊥ is 
measured as the ratio of these two 

ǁ
measured as the ratio of these two 

ǁ

signals.

3. Calculation of polarization or anisotropy

a. Polarization (P) is computed as:
 P = ( Iǁ / I⊥)-1/(( Iǁ / I⊥)+1)

b. Anisotropy (r) is computed as:

r = ( Iǁ / I⊥)-1/(( Iǁ / I⊥)+2)

ii. Traditional L-format Polarization of 
Fluorescence

1. Summary of the technique

a. The traditional L-format polarization 
set up with two polarizers, one 
on the excitation beam and the 
other before the detector.  Both the 
excitation and vertical polarizers 
move between the vertical and 
horizontal positions.

2.  Measurement of POF data

a. Prior to measurement of anisotropy 
or polarization, a G-factor value 
must be obtained.  This is obtained 
by moving the excitation polarizer 
to the horizontal position.  The 
intensity with the emission polarizer 
in the vertical (IHV) and horizontal 
(IHH) positions is then measured, 
and the G-factor is calculated as 
IHV/IHH.  The G-factor is used for 
all subsequent measurements.  This 
value is dependent on the emission 
wavelength and must be determined 
again if this wavelength is changed.

b. Anisotropy and polarization are 
measured using the excitation 
polarizer in the vertical position.  
Data are collected with the emission 
polarizer in the vertical (IVV) and the 
horizontal (IVH) positions.  Iǁ / I⊥ is 
defined as the ratio corrected for the 

ǁ
defined as the ratio corrected for the 

ǁ

G-factor:

Iǁ / I⊥ = IVV/(IVH*G)

3. Calculation of polarization or anisotropy

a. Polarization (P) is computed as:

P = ( Iǁ / I⊥)-1/(( Iǁ / I⊥)+1)

b. Anisotropy (r) is computed as:

r = ( Iǁ / I⊥)-1/(( Iǁ / I⊥)+2)

Appendices
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iii. Traditional T-format Polarization of 
Fluorescence

1. Summary of the technique

a. The traditional T-format polarization 
set up with three polarizers, and 
two emission polarizers.  Two 
emission detectors are used, each 
with a fixed polarizer and either 
a monochromator or filters for 
wavelength selection.  One polarizer 
is fixed in the vertical position and 
the other in the horizontal. This 
allows for calculation of Iǁ / I⊥ with 
no polarizer movement, allowing for 

ǁ
no polarizer movement, allowing for 

ǁ

rapid data collection.

2.  Measurement of POF data

a. As with the L-format configuration, a 
correction factor must be collected 
prior to measurement of anisotropy 
or polarization.  This is obtained 
by moving the excitation polarizer 
to the horizontal position.  IVV and VV and VV
IVH are detected using the vertical 
and horizontal emission polarizers, 
respectively.  The G-factor correction 
is calculated as IVV/IVV/IVV VH.  This value is 
dependent on the emission wavelength 
and the gain settings for the emission 
detectors.  It must be determined again 
if this wavelength is changed.

b. Anisotropy and polarization are 
measured using the excitation 
polarizer in the vertical position.  
Data are collected with both IVV and 
IHH emission detectors.  Iǁ / I⊥ is 
defined as the ratio corrected for the 

ǁ
defined as the ratio corrected for the 

ǁ

G-factor:

Iǁ / I⊥ = IVV/(IVH*G)

3. Calculation of polarization or anisotropy

a. Polarization (P) is computed as:

P = ( Iǁ / I⊥)-1/(( Iǁ / I⊥)+1)

b. Anisotropy (r) is computed as:

r = ( Iǁ / I⊥)-1/(( Iǁ / I⊥)+2)

Appendices
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ii. Sample Titration Script

1. [Type]
 Titrator

 [Comment]
 Comment Section.

 [Scans]
 10 Number of scans/assays to take

 [Cuvette Volume]
This is the volume (in uL) that is put into 
the cuvette to ;make a measurement

 500

 [Mix Volume]
This number is the percentage of the 
total sample syringe ;volume to use 
during mix cycles.  Set to 0 to use 
cuvette volume.

 0

 [Syringes]
 Number of syringes the titrator is 

equipped with.
 2

 [Sample Syringe]
Designates which syringe is to be used 
as the sample ;syringe acceptable 
values are 1-n where n=number of 
syringes present

 1

 [Starting Volumes]
Volume to be drawn into syringe at 
the beginning of the ;experiment.  This 
volume must meet or exceed the volume 
;to be delivered by the syringe.  For the 
sample syringe, this ;volume represents 
the starting sample volume.
Syringe

  1 2 3 4
  1000 1000 1000 1000 

 [Scan Data]
Note: Sample syringe (as designated 
above) values ;entered here are ignored, 
the actual volume used is ;calculated by 
the software.  An addition volume must 
be ;supplied for all syringes (as specified 
above in the ;Syringes section).  You may 
enter a 0 volume if a syringe ;does not 
need to be used for any particular scan.

Appendices
3. Sample Scripts

i. Sample Temperature Script

1. [Type]
 Temperature

 [Comment]
 Comment Section.

 Any amount of text and/or white space 
may be put into the Comment Section.  
Any comments outside of the comment 
section (line comments) MUST be 
preceded with a semi-colon, and all text 
following a semi-colon on a single line 
is ignored.  Scriptfiles are divided into 
different sections by section headers 
(header names enclosed in square 
brackets).  Section headers must start 
in the first column, and no other data, 
including comments, can follow them.  
Different types of scripts will contain 
different sections.  The only sections 
guaranteed to be in every script file are 
Type and Scans.  A comment section is 
optional but can also be placed in any 
script file.

 [Scans]

 10 ;Number of scans/assays to take

 [Scan Data]

 ;Data for each scan consists of a 
temperature (in degrees C) ;and an 
incubation time (in minutes) for the 
machine to ;wait before collecting data 
after the temperature control ;device has 
reached the desired temperature.

Temp Incubation
 20 3
 25 3
 30 3
 35 3
 40 3
 45 3
 50 3
 55 3
 60 3
 65 3



69

  Syr1 Syr2 Incubation Mix 
     cycles
  ---- ---- ---------- ----------
  20 10 0 1
  20 10 0 1
  20 10 0 1
  20 10 0 1
  20 10 0 1
  20 10 0 1
  20 10 0 1
  20 10 0 1
  20 10 0 1
  20 10 0 1

iii. Sample Enzyme Assay Script

1. [Type]
 EnzAssay

[Comment]
 Comment Section.

Any amount of text and/or white space 
may be put into the Comment Section.  
Any comments outside of the comment 
section (line comments) MUST be 
preceded with a semi-colon, and all text 
following a semi-colon on a single line 
is ignored.  Script files are divided into 
different sections by section headers 
(header names enclosed in square 
brackets).  Section headers must start 
in the first column, and no other data, 
including comments, can follow them.  
Different types of scripts will contain 
different sections.  The only sections 
guaranteed to be in every script file are 
Type and Scans.  A comment section is 
optional but can also be placed in any 
script file.

 [Scans]
 10 Number of scans/assays to take

 [Syringes]
 4 Number of syringes to be used 

must be equal to or less than the actual 
number of syringes present in the 
machine.  If this number is less than the 
actual number of syringes present then 
syringes 1-n will be used where n is the 
number of syringes specified here

 [Starting Volumes]
 Syringe
  1 2 3 4
 1000 1500 2000 5000 

These are the volumes that will be drawn 
into the syringes ;prior to the beginning 
of data collection.  You must supply ;a 
volume for each syringe to be used and 
this volume must ;be equal to or greater 
than the sum of all additions to be ;made 
from each syringe and less than or equal 
to the ;maximum volume of the syringe.

 [Priming Data]
 Volume to be delivered to fill tubing prior 

to beginning of data collection.  Set 
these to zero if you plan on filling the 
tubing by hand

 Syringe
  1     2     3     4
  0     0     0     0 

 [Scan Data]
 Any volume can be specified for an 

addition (including 0uL). The volumes (or 
sum of volumes) for a single scan/assay 
may ;be greater than the actual cuvette 
volume to insure previous contents of 
cuvette are evacuated entirely.

 Syringe
  1 2 3 4
 100 100 10 290 Assay 1
 100 100 20 280
 100 100 30 270
 100 100 40 260
 100 100 50 250 Assay 5
 100 100  60 240
 100   100    70   230
 100   100    80   220
 100   100    90   210
 100   100   100   200 Assay 

10

iv. Sample Wavelength Script

1. [Type]
 Wavelength

 [Comment]
 Comment Section... anything between 

the comment header and the following 
header is considered a comment

Appendices
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following a semi-colon on a single line is 
ignored. Scriptfiles are divided into 
different sections by section headers 
(header names enclosed in square 
brackets).  Section headers must start 
in the first column, and no other data, 
including comments, can follow them.  
Different types of scripts will contain 
different sections.  The only sections 
guaranteed to be in every script file are 
Type and Scans.  A comment section is 
optional but can also be placed in any 
script file.

 [Scans]
 10 Number of scans/assays to take

 [Scan Data]
 Data for each scan consists of an Angle 

(in degrees)

 0
 10
 20
 30
 40
 50
 60
 70
 80
 90
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 [Scans]
 11 Number of scans/assays to take

 [3rd Axis Mono]
 Use the mono's number as the identifier 

here.
 Acceptable values are: 1 -> the number 

of monochromators you have.
 1

 [Scan Data]
 Wavelengths/Wavenumbers
 The desired units must be selected 

on the 'Operational Modes' tab in 
the software. If a value can NOT be 
reached, the closest possible value to it 
will be reached and reported instead.

 All available monochromators MUST be 
listed here.

 If you do not wish to script its movement 
between scans, then you MUST fill its 
column's data with a '-' (dash) for each 
scan taken...this tells the software to 
ignore it for ;scripting.  You can safely 
ignore any monochromators you do 
not actually have.  Incubation time is in 
seconds.

  Incubation Mono. 1 Mono. 2 
---------- ------- ------- 

  0 200 -
  0 210 -
  0 220 -
  0 230 -
  0 240 -
  0 250 -
  0 260 -
  0 270 -
  0 280 -
  0 290 -
  0 300 -

v. Sample Angle Script

1. [Type]
 Angle

 [Comment]
 Comment Section.

Any amount of text and/or white space 
may be put into the Comment Section.  
Any comments outside of the comment 
section (line comments) MUST be 
preceded with a semi-colon, and all text 
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4. Test Data

i. Overhead light spectrum (Hg lines)

1. Set the emission monochromator 
bandwidth to something around 1 nm.

2. If the fluorescence lamp is on, ensure 
that the excitation shutter is closed or 
the light beam blocked by a slit.

3. Set the PMT HV for the detector to 600 
V if an analog PMT is used.

4. Open the sample chamber lid and place 
a piece of paper in the cuvette holder.  
This should be oriented such that light 
is reflected from the overhead lights into 
the emission monochromator.

5. Move the emission wavelength to 436 
nm and click on the Live Mode button on 
the Live Display page.  Note the sample 
signal and adjust the PMT HV to give a 
signal of 1-8 V.

6. On the Live Display page, set the 
emission monochromator Scan Range 
from 350 to 550 nm.  Set the Number of 
Increments to 400, and the Integration 
Time to 0.5 sec.

7. Click Collect Data to begin the emission 
scan.

8. Typical fluorescence overhead lights will 
exhibit a broad background peak from 
about 400 nm-550 nm.  Additionally, 
sharp Hg lines will appear at 365 nm, 
405 nm, 408 nm, 436 nm, and 546 nm.  
Some lamps may contain Ar as well.  
This gives a broader peak at 488 nm.
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ii. Raman Spectrum of water

1. Insert a cuvette containing highly 
pure water into the instrument sample 
compartment.

2. On the Operational Modes page, ensure 
the Data Collection Mode is set to Scan.

3. Set the emission and excitation slits to 5 
nm bandpass (1.24 mm slits with DM 45).

4. On the Live Display page, set the Scan 
Range for the Excitation monochromator 
from 350 nm to 350 nm (both values 
are identical).  Set the Emission 
Monochromator Scan Range From 
360 nm to 460 nm.  The Number of 
Increments should be 100 and the 
Integration Time set to 1 sec.  Set the 
PMT HV to 950 V.

5. Click Collect data to obtain a scan, 
and choose ‘Yes’ to post the dataset to 
GlobalWorks after collection.

6. Note the intensities of the baseline and 
peak (397 nm).  Subtract the baseline 
from the peak height.  This is the signal 
intensity.

7. On the Tools menu, locate Create Data 
Subset.  Enter 430 nm to 460 nm as the 
wavelength range.  Click on this new set 
of data and choose 2D Fits from the Fits 
menu.  Ignore the warning about fitting 
non-kinetic data.  Choose the linear 
model to be fit and click on Fit Data.
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8. Divide the signal intensity determined 

above by the standard deviation from 
the 2D fit.  This is an estimate of the 
RMS noise.  The result is the S/N for this 
measurement.

iii. N-Acetyl Tryptophanamide/ N-
bromosuccinimide (stopped flow)

1. This test reaction is used for stopped 
flow and involves quenching the 
fluorescence of a tryptophan analog by 
bromonation using N-bromosuccinimide.

2. Obtain samples of N-acetyl-
tryptophanamide (NATA) and N-
bromosuccinimide (NBS).  Prepare a 1 
mM solutions of   in water.  Dilute the 
NATA to a concentration of 200 µM and 
load one of the stopped flow syringes.  
This procedure assumes that the 
stopped flow syringe ratio is 1:1.  Please 
correct any calculations appropriately, 
if the syringe volume ratio is different.  
Place water in the other syringe.

3. Push two shots of NATA into the 
observation cell.

4. On the Live Display page, set the 
Excitation Wavelength to 290 nm 
and the Emission Wavelength to 350 
nm.  Set the spectral bandwidth to at 
least 5 nm by adjusting the slitwidth 
of both the excitation and emission 
monochromators.

5. On the Live Display page, click on the 

Live Mode button and adjust the PMT 
HV to obtain a signal.  It is advisable 
to obtain a signal of at least 0.5 V.  It 
may be necessary to increase the 
concentration of NATA if adjusting the 
PMT HV is not sufficient.

6. Add NBS to the other syringe.  If the 
NATA concentration has not been 
changed, use 300 µM.  For higher 
NATA concentrations increase the NBS 
concentration in slight excess of the 
NATA.

7. Set the Data Collection Time to 1 sec, 
and ensure the valves are in Flow 
position.  Click on the Show Pre-trigger 
Data checkbox.

8. Push two shots of reagents into the cell.

9. Click Collect Data to start the reaction.

10. The resulting curve should be an 
exponential fluorescence decay and time 
zero should represent the beginning of 
the exponential decay.
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5. Experimental Scripts
 Experiment Scripts : Automation in 

SpectralWorks

 Summary:
Olis SpectralWorks allows for the use of 
Experiment Scripts which enables multiple data 
collection events to occur without any user 
intervention.  For example, scans of differing 
scan ranges can be collected on a sample 
automatically.  The process uses protocols, 
which are instrument files to define the settings 
for each data collection event.  In the above 
example, a protocol would exist for each scan 
range.  An experiment script is then used to 
define the order of execution of the protocols 
and what file names are given to the resulting 
datasets.  Pauses may also be inserted to 
allow for sample manipulation.  Experimental 
scripts can also be run to remotely control 
SpectralWorks, as the software will automatically 
start when an experiment script is activated.

 Creating Protocols:

1. Change current instrument settings to 
those required for collecting the first 
step of the automation.  For example, 
if the first step is a single wavelength 
measurement at 500 nm, change the 
Data Collection mode to assay, the 
assay wavelength to 500 nm, and 
the total assay time to the required 
integration time.

2. Choose Save Protocol from the File 
menu, and follow the prompts to save 
the protocol.

3. Change the desired settings for the next 
step in the automation.  In the example 
measure a second wavelength, say 550 
nm, by changing the Assay Wavelength 
to 550 nm and saving the protocol.

4. Repeat the above procedure for each 
step of the automation.

 Creating an Experiment Script

1. Experiment Scripts can be created using 
Notepad or any other word processing 
program that stores files in a standard 
ASCII format.

2. By default, the OLIS software installation 
will associate the file extension ‘.es’ 
with SpectralWorks. (NOTE: This can 
be modified freely [meaning that users 
may choose an different file extension 
for the Experiment Scripts and associate 
the GlobalWorks exe with that extension 
manually] as the software will actually 
identify the file as an Experiment Script 
using a tag within the file itself.)

3. The tag ‘[Experiment Script]’ must 
located on the first line of the script

4. Each line of the script should contain 
one of the following tags:

(1) ‘[PROTOCOL]’ : Should be followed 
by a complete path and name for the 
protocol to use for the experiment. (i.e. 
C:\Program Files\OLIS GlobalWorks\
Protocols\Protocol#1.olp) NOTE: This 
must be a OLIS Protocol file [.olp]. 

AND

(2) ‘[DATA]’ : Followed by the path & 
name of the file to stored the collected 
data in. (i.e. C:\Program Files\OLIS 
GlobalWorks\Data\MyData#1.ols) NOTE: 
Currently data must be stored in the 
default OLIS file format [.ols].

OR

(3) (3) ‘[PAUSE]’ SpectralWorks pauses 
processing after reading in the Protocol 
located on the next line of the script. 
This allows for samples to be changed.

5. Each line of the script must end with 
carriage return/line feed.

6. Example Script:

 [Experiment Script]
 [PROTOCOL]E:\Olis Work\Automation\GlobalWorks\

DataView\Protocols\3000-2600 75pts.olp [DATA]C:\Program 
Files\OLIS GlobalWorks\Demo Data\Auto\Data1.ols

 [PAUSE]
 [PROTOCOL]E:\Olis Work\Automation\GlobalWorks\

DataView\Protocols\2100-2580 50pts.olp [DATA]C:\Program 
Files\OLIS GlobalWorks\Demo Data\Auto\Data2.ols

 [PAUSE] 
 [PROTOCOL]E:\Olis Work\Automation\GlobalWorks\

DataView\Protocols\2000-2300 15pts.olp [DATA]C:\Program 
Files\OLIS GlobalWorks\Demo Data\Auto\Data3.ols
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